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Information 

Copyright 

This document is copyrighted by Osprey Technologies, Inc., a wholly owned 
subsidiary of ViewCast Corporation. No part of this specification may be reproduced, 
transcribed, transmitted or stored in a retrieval system in any part, or by any means 
without the express written consent of Osprey Technologies, Inc. 

Disclaimer 

Osprey Technologies, Inc. reserves the right to change any products herein at any 
time and without notice. ViewCast Corporation and Osprey Technologies, Inc. make 
no representations or warranties regarding the content of this document, and 
assume no responsibility for any errors contained herein. 

Trademark Acknowledgment 

Osprey-50, Osprey-100, Osprey-101, and Osprey-200 are trademarks of Osprey 
Technologies, Inc.. Microsoft, Windows 2000, Windows XP, Windows NT, NetMeeting, 
NetShow, and Video for Windows are trademarks or registered trademarks of 
Microsoft Corporation. Indeo is a registered trademark of Ligos Technology 
Corporation. CU-SeeMe is a registered trademark of White Pines Software, Inc. IP/TV 
Server and IP/TV Viewer are registered trademarks of Precept Software, Inc. Real 
Video is a registered trademark of RealNetworks, Inc. Adobe Premiere is a registered 
trademark of Adobe Systems, Inc. Any other product names, trademarks, trade 
names, service marks, or service names owned or registered by any other company 
and mentioned herein are the property of their respective companies. 

FCC Notice 

This device has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
device generates, uses, and can radiate radio frequency energy, and if not installed 
and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this device does cause harmful interference to 
radio or television reception, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

♦ Reorient or relocate the receiving antenna. 

♦ Increase the separation between the computer and the receiver. 

♦ Connect the computer into an outlet on a circuit different from that to which 
the receiver is connected. 

♦ Consult the dealer or an experienced radio/TV technician for help. 

Shielded Cables 

Connections between this device and peripherals must be made using shielded 
cables in order to maintain compliance with FCC radio emission limits. 



 

Modifications 

Modifications to this device, not approved by Osprey Technologies, Inc., could void 
the authority granted to the user by the FCC to operate the device. 

Note to CATV Installer 

This reminder is provided to call to the CATV installer’s attention Section 820-40 of 
the NEC, which provides guidelines for proper grounding and, in particular, specifies 
that the cable ground shall be connected to the grounding system of the building, as 
close to the point of cable entry as practical. 
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Chapter 1 - Getting to Know the Osprey 
Multimedia Capture Cards 

The User’s Guide provides helpful information about installing and configuring the 
hardware and software for the Osprey-100, Osprey-101, and Osprey-200 devices. 
This book has been designed with the particular needs of end users in mind, 
particularly first-timers and those working with existing applications. 

Symbols 

Introduction 

Features 

Software Included 

Compatible Third Party Applications 

Getting Help 

Symbols 

 
This symbol denotes an important note or warning. 

 

The chapters that describe how to use Osprey application contain step-by-
step instructions. The “Shortcut” icon identifies a section that summarizes 
the detailed steps. 

Introduction  

 

If you already have a working knowledge of the Osprey cards and their 
capabilities, you may want to skip ahead to Chapter 2, Hardware and 
proceed with installation. 

Osprey Multimedia Capture Cards provide economical solutions for capturing video 
images in an uncompressed digital format. All formatting and scaling of images are 
processed within the hardware, allowing for maximum system efficiency and speed. 
The Osprey-200 in addition provides an on-board audio capture capability. 
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This User's Guide covers five main models of Osprey Multimedia Capture Cards: 

1. Osprey-100 – the mainstream video-only product. 

2. Osprey-150 – similar to the Osprey-100, designed for Sun PCI workstations but 
usable on Windows systems as well. 

3. Osprey-101 – a video-only product with a bundled NTSC camera. 

4. Osprey-200 – a video capture card with on-board audio capture capability. 

The “video only” models work with your existing sound card for audio capture. 

5. The Osprey-50-PCI is an entry-level video-only capture board similar to the 
Osprey-100. It comes with its own User's Guide and software applications. Most 
of the information in this User's Guide is applicable to it, however, and it uses 
the same video capture driver as the Osprey-100 and -200 devices. 

These products consist of a PCI board (based on the Conexant Bt878 single-chip 
video capture device) and Video for Windows compliant software drivers for Windows 
2000, Windows XP, Windows NT 4.0, and Windows 95/98 platforms. 

The driver for Windows 95/98 is a separate driver with its own User's Guide. All 
information in this User's Guide refers to the Windows 2000, Windows XP, and 
Windows NT drivers. 

Features 

The driver supports all Video for Windows capture driver capabilities that are 
available to the Bt848 / Bt878 hardware device. It is compatible with software video 
compressors, sound boards, video editing applications, and videoconferencing 
applications. Features include: 

♦ Connectors – Osprey-50: One Composite Video In, one S-Video In. 

♦ Connectors – Osprey-100: Three Composite Video In, one S-Video In. 

♦ Connectors – Osprey-101: One Composite Video In, one S-Video In; power 
out for camera. 

♦ Connectors – Osprey-200: One Composite Video In, two stereo Audio In  
(left = white, right = red) 

♦ Input formats: NTSC (M, J); PAL (B, D, G, H, I, M); SECAM 

♦ Display formats: RGB32, RGB24, RGB15, Grey8, 4:2:2 packed, YUV12, YVU9 

♦ Standard frame sizes: full, half, 3/8, 1/4. 

♦ Square pixel and CCIR601 aspect ratios. 

♦ Custom frame sizes. 

♦ Interactive control of brightness, hue, contrast, and saturation. 

♦ Closed captioning. 

♦ Multiple boards per system. Multiple applications can each access different 
boards, or a single application can access multiple boards. You can install only 
one Osprey-50 per system; however, you can install multiple Osprey-100s, -
101s, -150s, or –200s along with it. 
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♦ The Osprey-200 adds audio PCM capture through an audio waveform (.wav) 
driver. You can capture audio at 8 and 16 bits per sample, stereo or mono, at 
a number of sampling rates. 

♦ 8 kHz 

♦ 11.025 kHz 

♦ 16 kHz 

♦ 22.05 kHz 

♦ 32 kHz 

♦ 44.1 kHz 

♦ The Osprey-200 accepts -10dBV standard line level audio input. 

Video Frame Rates 

Video Frame Rates 

Depending on the system’s load and display window size, the Osprey Capture Cards 
can display and capture video at rates of up to 30 frames per second for NTSC 
formats, 25 frames per second for PAL and SECAM formats. Keep in mind, though, 
that video frame rates for display, streaming, videoconferencing, and capture are 
application-dependent. The package supports Direct Draw for drawing video overlays 
with minimal load on the system processor.  

Software Included 

The products for Windows 2000, Windows XP, and Windows NT 4.0 include the 
following: 

♦ A Video for Windows compatible video capture driver capable of being 
upgraded to SimulStream. 

♦ An audio capture driver (Osprey-200 only). 

♦ VidCap32 — a simple capture application and testing and demo program. 

♦ AmCap – a simple capture application and testing and demo program using 
the DirectX API (the same as Windows Media Encoder). 

♦ A Control Panel applet. 

♦ Ligos Technology’s Indeo package of software-based video codecs and 
compressors. 

Beginning with Version 2.0.0, the driver is SimulStream capable. SimulStreaming is 
an added-cost upgrade that allows the driver to capture and display video and audio 
to multiple destinations from a single card. Please see the SimulStreaming User’s 
Guide which is installed in the Osprey MultiMedia Capture Program group for details 
about this feature. 
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Compatible Third Party Applications 

The driver is designed to be compatible with all Video for Windows applications. It is 
tested for compatibility with the following applications, either by us or by third 
parties: 

Inter/Intranet video servers 

Video conferencing 

Video editing 

Other Video for Windows applications are being added to this list. Refer to the 
ViewCast Corporation web site for the current list - 
http://www.ospreyvideo.com/.  

Inter/Intranet video servers 

♦ Microsoft Windows Media Encoder 

♦ RealNetworks RealProducer  

Video conferencing 

♦ Microsoft NetMeeting 

Video editing 

♦ Adobe Premiere 

♦ MGI VideoWave 

Getting Help 

Before calling for help, first do the following: 

♦ Work through the section of Chapter 3 entitled Testing the Installation. 

♦ Read through Chapter 9, Troubleshooting. 

♦ Visit our web site at http://www.ospreyvideo.com/ and read the Osprey-
100 and Osprey-200 FAQ’s by selecting Osprey-100 or Osprey-200, then 
clicking on the FAQ button. 

http://www.ospreyvideo.com/
http://www.ospreyvideo.com/
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If you’ve done that and you’re still having problems, please contact the Osprey 
Support Group at: 

(888) 684-6622 (voice, toll-free) 

(919) 319-9200 (voice) 

(919) 319-9814 (FAX) 

mailto:support@ospreyvideo.com (email) 

When you contact us, especially if it is by email, include the following information: 

♦ What product you have – Osprey-50, -100, -101, -200. We need to know this 
because we have an Osprey-1000 series of products as well as the Osprey-
100 series. 

♦ What operating system you are using. The Osprey capture card drivers for 
Windows 2000, Windows XP, Windows NT 4.0, and Windows 95/98 are all 
different. 

♦ For Window NT 4.0 only: Whether your machine has an X86-compatible or 
Alpha processor. 

♦ What version of the Osprey capture driver you are using. The version 
information is on the title bar of the driver’s Control Dialog, as well as in the 
first message of the installation program. 

♦ A description of the problem. If possible, get the problem to appear with the 
VidCap32 application, and tell us whether it appears in Preview, Overlay, 
and/or Capture mode. If the problem appears only with a third party 
application, tell us what the application is and what version of it you are 
using. 

♦ Any additional details about your system configuration would be helpful – for 
example, the system speed, processor type, motherboard chipset, whether 
you have a SCSI or IDE hard drive, whether you have a network adapter 
card, and the type of display adapter card.  

mailto:support@osprey.viewcast.com
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Chapter 2 - Osprey Capture Card 
Hardware 

The Osprey Multimedia Capture Cards are 32-bit, 5-volt variable height short PCI 
cards. They are compliant with version 2.2 of the PCI hardware specification. 

 

 
The exact card options and appearance are different for the various Osprey 
multimedia capture products, and are subject to change. 

System Requirements 

Configuring the Card 

Installing the Card 

Connecting Cables 

System Requirements 

The minimum capability of the computer for the capture card itself is fairly low.  It is 
typically the application being used with the capture card that sets the minimum 
requirements of the computer.  For example, pure video capture applications 
typically do not require hefty machines.  Yet the various streaming encoding 
applications, for example RealProducer or Windows Media Encoder, may require up 
to dual 2 GHz processor for some of their challenging encoding profiles. 

For x86 PCs, the minimum system requirements are as follows: 
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♦ 300 MHz Pentium II processor or higher with at least 128Mb RAM  

♦ One available PCI slot 

♦ Windows NT 4.0, Windows 2000, or Windows XP, 

♦ Approximately 7.5 megabytes of storage for system files 

For optimum performance, we recommend at least the following additional features. 

Video display adapter with: 

♦ 4 MBytes memory minimum (8 Mbytes or more recommended) 

♦ Direct Draw capability 

♦ An up-to-date display device driver with Direct Draw capability 

 

Disk space needed to capture one minute of video at a resolution of 
320x240 is as follows for three representative formats: 

♦ 24-bit uncompressed capture, 30 frames per second: 396 Mbytes. 

♦ YVU9 uncompressed capture, 30 frames per second: 148 Mbytes. 

♦ 24-bit compressed capture, 30 frames per second: approximately 
16 Mbytes. 

♦ A sound card. 

♦ With the Osprey-50, -100, and -101, you can capture audio 
with your system sound card. 

With the Osprey-200, you can use on-board audio capture capability to 
capture sound. You can use multiple cards to capture multiple audio/video 
streams. You still need a sound card to monitor or play back the audio. 

Configuring the Card 

Osprey capture cards do not have any switches or jumper settings that you need to 
configure.  
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Installing the Card  

 

All computer cards are sensitive to electrostatic discharge. Slight 
discharges from clothing or even from the normal work environment can 
adversely affect these cards. By following these simple guidelines, 
however, you can minimize the chance of damaging your Osprey card. 

♦ Handle cards only by the non-conducting edges. 

♦ Do not touch the card components or any other metal parts. 

♦ Wear a grounding strap while handling the cards (if in a high static 
area). 

♦ Provide a continuous ground path by leaving the power cord 
plugged into a grounded power outlet. 

♦ Ensure that the workstation is powered OFF before installing any 
components. 

 

If you are not familiar with how to install a PCI bus card, refer to your 
system’s documentation for more complete, step-by-step instructions. 

You should install the Osprey card before installing the software driver. However, 
with Windows 2000 and Windows XP you also have the option to 'preinstall' the 
software before installing the hardware. 

Use the following steps to install the Osprey card: 

1. Power down the computer. Make sure that the computer’s power switch is 
turned OFF. Read caution note above for grounding precautions. 

2. Remove the computer’s cover. 

3. Locate an empty PCI slot. 

4. Remove the slot-cover screw from the empty PCI slot’s cover, set the screw 
aside, and remove the slot cover. 

5. Remove the card from its anti-static bag. 

6. Install the Osprey card into the empty slot. 

 Be sure that the card is seated evenly into the slot. 

7. Secure the backpanel of the card with the slot’s cover screw. 

8. Replace the computer cover. 

9. Connect video and audio cables to the Osprey card. The Connecting Cables 
section shows details of the card’s backpanel connectors. 

10. Turn the computer on.  
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Connecting Cables 

 

Osprey-100 

 

Osprey-101 

 

Osprey-200 

 

Osprey-50 

 

 Exact connector layouts are subject to change. 

Connecting a Composite Source 

Connecting an S-Video Source 

The Osprey-101 Video Camera 

Connecting an Audio Source to the Osprey-200 

Connecting Audio with the Osprey-50, -100, and -101 
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Connecting a Composite Source 

If your video source provides only composite video, connect the source’s output 
cable to an RCA Composite Video In connector. On the Osprey-100 with three 
connectors, the connector furthest from the S-Video connector is designated 
“Composite 1,” and the one nearest it is “Composite 3.”  

Connecting an S-Video Source 

If your video source supports S-Video, connect the source’s output cable to the  
S-Video In connector on the Osprey card. Compared to composite signals, S-Video 
provides a sharper image with better color separation. S-Video uses a four-pin mini-
DIN connector that provides separate Y (luminance) and C (chrominance) signals. 
Chapter 6, The Control Dialog, explains how to configure the driver for S-Video.  

The Osprey-101 Video Camera 

The Osprey-101 video camera has an attached cable with two connectors. One is a 
composite video connector that plugs into the Composite input connector of the 
Osprey-101 board. The other is a power plug that connects to the power connector 
on the board.  

Connecting an Audio Source to the Osprey-200 

The Osprey-200’s audio connectors are made for line level audio stereo equipment, 
such as VCR or DVD outputs and can also take headphone level outputs when the 
volume is adjusted midway between high and low settings. It should be noted that if 
you are using a camcorder or VCR with only a single audio output, the volume needs 
a slight adjustment. 

Although the Osprey-200 will accept RCA line level inputs, the standard microphone 
shipped with most soundcards is not compatible. You will need to use a powered 
microphone using RCA connectors with 1-volt peak to peak output.  

Connecting Audio with the Osprey-50, Osprey-100, and 
Osprey-101 

These cards do not have an on-board audio connection. Connect your audio source 
to your system soundcard’s line or microphone input. Refer to the soundcard or PC 
manufacturer’s instructions regarding input signal specifications and audio 
adjustments.  
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Chapter 3 - Installing the Software - 
Windows 2000 

 

The Windows NT 4.0 Osprey drivers do not work with Windows 2000. If 
your Osprey card(s) were installed under the Windows NT 4.0 operating 
system and the PC has now been upgraded to Windows 2000, you need to 
install the Windows 2000 drivers. 

Please note: 

♦ Administrative privileges are required for installation. 

♦ Before installing software, check the ViewCast support website or 
the ftp site for the any driver update releases subsequent to the 
software shipped on your CD. For the ViewCast support website, 
go to http://www.ospreyvideo.com/ > Downloads > Software 
and Drivers.  Select the operating system and card type. To reach 
the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-200/win2000/latest. It's 
a good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what appear on your computer screen. In some cases, 
version numbers and other minor differences may appear in the 
installation you are running. 

Basics: Installing From CD 

Basics: Downloading and Installing Updated Drivers 

Canceling Out of Found New Hardware Wizard 

Three Install Scenarios 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Scenario 3: Osprey Card(s) Physically Installed, and Previous Osprey 
Software Installed 

Installing Ligos Technology's Indeo 

Testing the Installation 

Uninstalling the Software 

http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/pub/OSP-200/win2000/latest
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Basics: Installing From CD  

1. Insert the Osprey CD into your CDROM drive. The installation instructions will 
assume this is the "D:" drive. Substitute the proper drive name as it appears on 
your system where appropriate. 

2. Run the installation program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter d:\win2000\setup.exe in the dialog box. 

d. Click OK.  

Basics: Downloading and Installing 
Updated Drivers  

1. The latest software drivers for Osprey Multimedia Capture Cards are available 
via FTP (file transfer protocol), at the following locations: 

ftp://ftp.viewcast.com/pub/OSP-100/win2000/latest 

ftp://ftp.viewcast.com/pub/OSP-200/win2000/latest 

The same driver is used for the Osprey-50/-100/-101 and Osprey-200, so these links 
point to the same download file. 

There are also links to the drivers from our web site, 
http://www.ospreyvideo.com/ 

2. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com - and then click on the list of directories that will 
appear until you have reached the ...win2000/latest location. Refer to your 
browser’s help files for more specific and detailed assistance. 

3. Download the web package file in ...win2000/latest to your hard disk 

4. Run the web package program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter <pathname> in the dialog box, where <pathname> is the location 
and name of the file that you have downloaded. 

d. Click OK. 

e. The program will prompt you for a temporary location to unpack the install 
files to. 

ftp://ftp.viewcast.com/pub/OSP-100/win2000/latest
ftp://ftp.viewcast.com/pub/OSP-200/win2000/latest
http://www.ospreyvideo.com/
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These files will not be automatically deleted after setup has run. This is so 
that you can perform the manual Plug and Play install if you want to. So 
make a note of where these files are located, and delete them after the 
install if you want to conserve disk space. 

Canceling Out of the Found New Hardware 
Wizard 

When installing an updated Osprey-220 driver, first uninstall the existing driver and 
reboot the computer. The Found New Hardware wizard will run after this reboot.  

To cancel out of the Found New Hardware wizard:   

The Digital Signature Not Found window displays for the Osprey-220 video 
capture device. 

 

1. Click No. 

The Completing Found New Hardware wizard window displays. 
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2. Click Finish. 

The Digital Signature Not Found window displays for the Osprey-220 audio 
capture device. 

 

3. Click No. 

The Completing Found New Hardware wizard window displays. 

 

4. Click Finish. 

Three Install Scenarios 

There are three main situations that might apply to you: 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software not 
Installed 

Scenario 3: Osprey Card(s) Physically Installed, and Previous Osprey 
Software Installed 
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If you have upgraded from Windows NT 4.0 or Windows 95/98 and had Osprey 
drivers installed on the previous operating system, follow Scenario 3. 

In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file, then restart 
your computer and all the updated components will be installed. 

Scenario 1:  Osprey Card(s) not Physically Installed in the 
PC  

This is the method that we recommend if you are installing an Osprey card for the 
first time on a system, and the Osprey software has not yet been installed. This 
scenario is called the "Preinstall Scenario". After the install is run, as soon as an 
Osprey card is installed in the PC, it is detected and its drivers are started 
automatically. 

To preinstall the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 

3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 
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4. Click Next. 

The Information window displays. 

 

5. Click Next. 

The Software License Agreement window displays. 
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6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 

The Choose Destination Location window displays. 
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8. If you wish to change the destination location for the files, click Browse. Click 
Next. 

The Select Program Folder window displays. 

 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Start Copying Files window displays. 
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10. Click Next. 

The Ligos® Indeo® Information window displays. 

 

11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 

A question dialog window displays. 

 

12. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 
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13. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

14. Click Yes to continue the installation process. 

The Osprey Technologies Special Offers Shortcut window displays. 

 

15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

16. Click OK to continue the installation. 

The Product Registration window displays. 
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17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

18. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

19. Click Finish. 

 

When you start your computer after installing the Osprey hardware, the 
Found New Hardware Wizard runs upon detecting new hardware. 

http://www.ospreyvideo.com/
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After restarting the computer, the Digital Signature Not Found window displays 
for the Osprey-220 Video Capture Device. 

 

20. Click Yes. 

The Files Needed window displays. 

 

21. Click Browse. 

22. Navigate to the \WinNT\System32\drivers directory. 

23. Click Open. 

24. Click OK. 

The Digital Signature Not Found window displays for the Osprey audio capture 
device. 
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25. Click Yes to continue the installation. 

The Files Needed window displays. 

 

26. Click Browse. 

27. Navigate to the \WinNT\System32\drivers directory. 

28. Click Open. 

29. Click OK. 

The Completing Found New Hardware wizard window displays. 

 

30. Click Finish.  

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

Scenario 2:  Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options: 

Option A: Run the Installation Program (Recommended) 

Option B: Use the New Hardware Found Wizard (Not Recommended) 
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Option A: Run the Installation Program (Recommended) 

When windows 2000 is first started for the first time after the Osprey card is 
installed, the New Hardware Found wizard will appear one or more times. Cancel out 
of these wizards. After Windows 2000 has finished starting, perform the following 
steps. 

To install the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 

3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 

 

4. Click Next. 

The Information window displays. 
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5. Click Next. 

The Software License Agreement window displays. 

 

6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 
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7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 

The Choose Destination Location window displays. 

 

8. If you wish to change the destination location for the files, click Browse. Click 
Next. 

The Select Program Folder window displays. 
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9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Start Copying Files window displays. 

 

10. Click Next. 

The Ligos® Indeo® Information window displays. 
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11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 

The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 

12. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

13. Click Yes to continue the installation process. 

The Osprey Technologies Special Offers Shortcut window displays. 
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14. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

15. Click OK to continue the installation. 

The Product Registration window displays. 

 

16. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

http://www.ospreyvideo.com/
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17. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

18. Click Finish. 

19. Click Finish to complete the installation. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

Option B: Use the New Hardware Found Wizard (Not 
Recommended)  

This method is more complicated than Option A. It is particularly inconvenient if you 
are installing multiple cards at once, since each card has to be set up separately. 

When Windows 2000 starts, it detects the new card(s) and starts the New Hardware 
Found wizard. 

 

NOTE: For all Bt/Ct878-based Osprey cards, the Wizard detects two 
logical devices for each card - a Multimedia Video Controller device and a 
Multimedia Controller device. The Multimedia Video Controller is the video 
section of the Bt/Ct878 device; the Multimedia Controller is the audio 
section. The audio logical device is present even on Osprey-100 and 
Osprey-101 cards that have video or power connectors in place of the 
audio inputs. 

When the Hardware Wizard detects a device: 

 

Please note the terminology in the Add Hardware Wizard. It displays 
either Multimedia Video Controller or Multimedia Controller (the audio 
device). 

The Add New Hardware Wizard detects several new devices. Among these are the 
following: 

♦ Osprey Video Capture Device 

♦ Osprey Audio Capture Device (for Osprey-200 installations) 

♦ Osprey Function 1 Placeholder (for Osprey-100 and Osprey-101 installations) 
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A Found New Hardware window displays and is immediately obscured by the 
Welcome to the Found New Hardware Wizard window.  

 

 

1. Click Next. 

The Install Hardware Device Drivers window displays. 
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2. Select Display a list of the known drivers for this device so that I can 
choose a specific driver and click Next. 

The Hardware Type window displays. 

 

3. Scroll down to select Sound, video and game controllers and click Next. 

The Select a Device Driver window displays with a list of manufacturers and 
models of hardware devices. 

 

4. Click Have Disk and Next. 

The Install from Disk window displays. 
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5. Click Browse to locate file Win2000\o100drv.inf on your CDROM and click 
OK. 

The Select a Device Driver window displays. 

 

6. Select the Osprey Video Capture Device and click Next. 

The Start Device Driver Installation window displays. 
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7. Click Next. 

The Digital Signature Not Found window for the Osprey Video Capture 
Device will specifically identify the software about to be installed. 

 

8. Click Yes to continue with the installation process. 

The Completing the Found New Hardware Wizard window displays. 

 

9. Click Finish to complete installation of the video portion of the device driver. 

This sequence of events from steps 7 through 9 will repeat for the Osprey Audio 
Capture Device.  
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The Digital Signature Not Found window for the Osprey Audio Capture 
Device will specifically identify the software about to be installed. 

 

10. Click Yes to continue with the installation process. 

 
NOTE:  If you are installing multiple Osprey cards, you will repeat steps 7 - 
10 twice (once for video and once for audio) for each additional capture card. 

The System Settings Change window displays. 

 

11. Click Yes to restart the computer. A restart is not necessary for a video-only 
card such as the Osprey-100; a restart is required for an audio-video card such 
as the Osprey-200. 

 

The drivers for your new Osprey board are installed. However, to utilize 
the utility programs, create a program group, and access the online 
User's Guide, you must run the installation program. 

For detailed instructions on installing the other programs, refer to Scenario 2, 
Option A.  

Scenario 3:  Osprey Card(s) Physically Installed, and 
Previous Osprey Software Installed 

This scenario is for the case when the Osprey card is physically installed in the PC 
and there is a previous installation of the Osprey drivers. These methods work for 
upgrades either from an old Osprey Windows 2000 driver to a newer one, or – if you 
have upgraded the operating system – from a Windows NT 4.0 driver to a Windows 
2000 driver. 
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Under this scenario you have two options. With both options, it is not necessary to 
uninstall the old driver before installing the new driver. 

Option A: Run the Installation Program (Recommended) 

Option B: Use the Device Manager (Normally not Recommended) 

Option A: Run the Installation Program (Recommended) 

To install the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 

3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 

 

4. Click Next. 

The Information window displays. 
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5. Click Next. 

The Software License Agreement window displays. 

 

6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 
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7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 

The Choose Destination Location window displays. 

 

8. If you wish to change the destination location for the files, click Browse. Click 
Next. 

The Select Program Folder window displays. 
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9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Start Copying Files window displays. 

 

10. Click Next. 

The Ligos® Indeo® Information window displays. 

 

11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 

A question dialog window displays. 
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12. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 

13. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

14. Click Yes to continue the installation process. 

The Osprey Technologies Special Offers Shortcut window displays. 
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15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

16. Click OK to continue the installation. 

The Product Registration window displays. 

 

17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

http://www.ospreyvideo.com/
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18. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

19. Click Finish. 

20. Click Finish to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

After restarting the computer, the Digital Signature Not Found window displays 
for the Osprey-220 audio capture device. 

 

21. Click No. 

The Completing Found New Hardware wizard window displays. 
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22. Click Finish.  

 

The Osprey card does not need to be installed at this time. You also do 
not need to restart the computer again at this time. 

When the card is installed, Windows 2000 detects the card and 
automatically activates the driver. 

Option B: Use the Device Manager (Normally not 
Recommended) 

This method will only install the drivers. It will not update the bundled applications, 
User's Guide, or Start Menu. It is sometimes useful for repairing an installation 
where the driver seems to be incorrectly or incompletely installed. 

Note to Osprey-200 users: To completely update your audio and video drivers, you 
have to repeat steps 7 through 20 twice - once to update the audio driver, once to 
update the video driver. You can install the drivers in either order - either the audio 
driver first, or the audio driver first. The example here assumes that you are 
updating the audio driver. 

With video-only cards - Osprey-50, -100, and -101 - you need to update the video 
driver only. 

To update the drivers using the Device Manager:  

1. Click Start and select Settings. 

2. Select Control Panel. 

3. Double-click System. 

The System Properties window displays. 
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4. Select the Hardware tab. 

The Hardware tab displays. 

 

5. Click Device Manager. 

The Device Manager window displays. 

6. Double click the Sound, video and game controllers entry. 

The Sound, Video and Game Controllers entry expands. 
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7. If you are updating the audio driver, double-click Osprey Audio Capture 
Device. If you are updating the video driver, double-click Osprey Audio 
Capture Device. 

If you have two or more Osprey Capture Cards in the system there will be 
separate entries for each video device and each audio device. Click on any one 
of the devices to update the driver for all of them. 

A Properties dialog displays. 

 

8. Click the Driver tab. 

The Driver tab displays. 
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9. Click Update Driver. 

The Upgrade Device Driver Wizard displays. 

 

10. Click Next. 

The Upgrade Device Driver Wizard displays. 
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11. Click to select the Display a list of the known drivers for this device ... radio 
button. 

12. Click Next. 

The Upgrade Device Driver Wizard displays. 

 

13. Click Have Disk. 

The Install From Disk window displays. 

 

14. Click Browse to locate the O100DRV.INF file. 
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15. Click OK to return to the Upgrade Device Driver Wizard. 

The Upgrade Device Driver Wizard displays. 

 

16. Select the device to update: 

♦ If you are updating the Osprey-200 audio function, select Osprey Audio 
Capture Device. 

♦ If you are updating the video function of any Osprey capture card, select 
Osprey Video Capture Device. 

♦ The newer Osprey-50, -100, and -101 video-only cards have an on-chip audio 
interface that, while not usable, is nonetheless detected by Plug and Play. 
Install the Osprey Function 1 Placeholder to satisfy Plug and Play that the 
unused audio function is "installed" without copying unnecessary audio files to 
the system directory. 

17. Click Next. 

The Upgrade Device Driver Wizard displays. 
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An Update Driver Warning may display. If you have followed the 
instructions carefully, this is a safe operation. 

18. Click Next. 

The Digital Signature Not Found window displays. 

 

19. Click Yes to continue the installation. 

20. Click Finish to complete the wizard. 

21. In a moment the Device Manager screen updates. 

Osprey-200 users: If you have just upgraded the audio driver, repeat steps 7 
through 20 for the video driver. If you upgraded the video driver first, repeat 
steps 7 through 20 for the audio driver. 

If you have multiple boards installed in the system, then you normally need to 
update the audio driver and the video driver for just one device. You will have 
multiple capture devices to choose from, and you can pick any one of them. 

If, however, one or more Multimedia Video Controller or Multimedia 
Controller devices appear in the Device Manager list (as shown in step 6) that 
correspond to Osprey cards, then these will need to be individually installed, 
one device at a time. These devices will have a exclamation mark on a yellow 
field as part of their icon - indicating that they are not properly installed. They 
could be listed either under Sound, video and game controllers or under 
Other devices. Upgrade a Multimedia Video Controller as an Osprey 
Video Capture Device, and a Multimedia Controller as an Osprey Audio 
Capture Device or Osprey Function 1 Placeholder. Double click on each of 
these items and follow steps 7 through 20. When you are asked to specify the 
hardware type, select Sound, video and game controllers. 

22. Repeat steps 7 through 20 for the remaining capture device(s). For example, if 
you just upgraded the audio capture device, repeat these steps for the video 
capture device. 

 

You have to restart the system before you can use the updated drivers. 
There is one exception: If you have a single video-only card - a single 
Osprey-50, -100, or -101 - you do not have to restart, and can use the 
updated drivers immediately. 
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Installing Ligos Technology's Indeo 

 

Ligos Technology’s Indeo Video package contains software codecs and compressors 
that enhance the usefulness of the card. You need to install this package if you want 
to use the three YUV color formats 

♦ 4:2:2 packed 

♦ YUV12 

♦ YVU9 

There is also a software compressor which creates compressed video files in real 
time at full capture speed. Indeo is recommended if you will be using Microsoft 
Windows Media Encoder. This software is described in more detail in Chapter 8. 

To install Ligos Technology’s Indeo Video software:  

1. Click Yes to install Indeo Video software. Click No if you do not wish to install 
the software at this time.  

The Indeo® Installation window displays. 
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The Software License Agreement window displays. 

 

2. Click Yes. 

The Choose Destination Location window displays. 
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3. Click Next. If you wish to change the destination location for the files, click 
Browse. 

The Setup Type window displays. 

 

4. Select Developer and click Next. 

A question window displays. 

 

5. If you … then … 

 want to backup your 
system files, 

click Yes and proceed to step 6. 

The Choose Destination window displays. 

 do not want to backup your 
system files, 

click No and proceed to step 7. 

6. Type the path or click Browse to locate the path in which you want to save the 
backup of your system files. 
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7. Click Next. 

The Start Copying Files window displays. 

 

8. Click Next to proceed with the installation. Click Back to make any changes 
prior to the installation. 

After the files are copied to the system, the Indeo Software Setup Is Now 
Complete window displays. 

 

9. Click Finish.  
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Testing the Installation  

1. Verify the hardware installation is complete, in accordance with the directions in 
Chapter 2. 

2. Connect a camera, VCR, or other video signal source to the Osprey card’s 
connectors. 

3. Open the Osprey Multimedia Capture group in the Start menu. 

4. Click the VidCap32 icon. 

5. Verify the screen displays a still video frame from the Osprey-100 board. Click 
the Preview or Overlay button. The screen should display moving video 
frames. 

6. If the video area is a plain blue field, it could be for one of the following 
reasons: 

f. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector, or reconfigure the driver using 
its Control Dialog (refer to Chapter 6). 

g. The video source is not turned on or activated. 

7. If the video area is scrambled or has bad color, the signal format of your video 
source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL and SECAM 
equipment always need to change the driver’s signal format the first time they 
run the driver. Please see Video Standard in Chapter 6 - Capturing Video.  

Uninstalling the Software  

If you ever need to remove the Osprey driver from your system, proceed as follows: 

1. Open the Control Panel. 

2. Double-click Add/Remove Programs. 

3. Click to select Change or Remove Programs. 

4. Highlight the Osprey Multimedia Capture Driver entry. 

5. Click Change/Remove in the Osprey entry. 

The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete.  

8. Reboot your computer to complete the uninstall process. 



 Chapter 4 – Installing the Software – Windows XP 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 67 

Chapter 4 – Installing the Software – 
Windows XP 

The Osprey Capture Card products contains a single CD for Windows 2000, Windows 
XP, Windows NT 4.0 and Windows 95/98. The Windows 95/98 driver is an entirely 
separate driver that is not covered by this User's Guide. 

After you’ve installed the software, you can test the card and software by running 
the included application program, VidCap32. 

 

Please note: 

♦ Administrative privileges are required for installation. 

♦ Before installing software, check the ViewCast support website or 
the ftp site for the any driver update releases subsequent to the 
software shipped on your CD. For the ViewCast support website, 
go to http://www.ospreyvideo.com/ > Downloads > Software 
and Drivers.  Select the operating system and card type. To reach 
the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-200/winXP/latest. It's a 
good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what appear on your computer screen. In some cases, 
version numbers and other minor differences may appear in the 
installation you are running. 

Basics: Installing From CD 

Basics:  Downloading and Installing Updated Drivers 

Two Installation Scenarios 

Scenario 1:  Osprey Card(s) not Physically Installed in the PC 

Scenario 2:  Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Testing the Installation 

Uninstalling the Software 

http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/pub/OSP-200/winXP/latest
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Basics: Installing From CD  

1. Insert the Osprey CD into your CDROM drive. The installation instructions 
assume this is the "D:" drive. Substitute the proper drive name as it appears on 
your system where appropriate. 

2. Run the installation program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter d:\winxp\setup.exe in the dialog box. 

d. Click OK.  

Basics:  Downloading and Installing 
Updated Drivers  

1. The latest software drivers for Osprey Multimedia Capture Cards are available 
via FTP (file transfer protocol), at the following locations: 

ftp://ftp.viewcast.com/pub/OSP-100/winXP/latest 

ftp://ftp.viewcast.com/pub/OSP-200/winXP/latest 

The same driver is used for the Osprey-50, Osprey-100, Osprey-101 and Osprey-
200, so these links point to the same download file. 

There are also links to the drivers from our web site, 
http://www.ospreyvideo.com/ 

2. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com - and then click on the list of directories that display 
until you have reached the ...winXP/latest location. Refer to your browser’s 
help files for more specific and detailed assistance. 

3. Download the web package file in ...winXP/latest to your hard disk. 

4. Run the web package program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter <pathname> in the dialog box, where <pathname> is the location 
and name of the file that you have downloaded. 

d. Click OK. 

e. The program prompts you for a temporary location to unpack the install files 
to. 

ftp://ftp.viewcast.com/pub/OSP-100/winXP/latest
ftp://ftp.viewcast.com/pub/OSP-100/winXP/latest
http://www.ospreyvideo.com/
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These files are not be automatically deleted after setup has run. This is so 
that you can perform the manual Plug and Play install if you want to. So 
make a note of where these files are located, and delete them after the 
install if you want to conserve disk space. 

Two Installation Scenarios 

There are three main situations that might apply to you: 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software not 
Installed 

In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file, and all the 
updated components will be installed. 

Scenario 1:  Osprey Card(s) not Physically Installed in the 
PC  

This is the method that we recommend if you are installing an Osprey card for the 
first time on a system, and the Osprey software has not yet been installed. This 
scenario is called the "Preinstall Scenario". After the install is run, as soon as an 
Osprey card is installed in the PC, it is detected and its drivers are started 
automatically. 

To preinstall the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WINXP directory. 
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3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 

 

4. Click Next. 

The Software License Agreement window displays. 
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5. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

6. Click the radio button to select the default signal format.  See Video Standard 
for more information about signal formats. 

7. Click Next. 

The Information window displays. 
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8. Click Next. 

The Choose Destination Location window displays. 

 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Select Program Folder window displays. 
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10. Click Next. 

The Start Copying Files window displays. 

 

11. Click Next. 

The Ligos Indeo Information window displays. 

 

12. Click Next. 

The Pre-installation question window displays. 
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13. Click Yes. Skip to step 14 if you are installing the POST-WHQL driver version.

The Hardware Installation window displays. 

 

14. Click Continue Anyway. 

The files begin copying to the computer. 

 

The ViewCast Corporation/Osprey Video Division Special Offers Shortcut 
window displays. 

 

15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 
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16. Click OK to continue the installation. 

17. Click Next. 

The Product Registration window displays. 

 

18. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

19. Click to select No. 

20. Click Finish. 

 

When you start your computer after physically installing the Osprey 
hardware, the Found New Hardware Wizard runs upon detecting new 
hardware. The sequence of windows are similar to that in Appendix H - 
Adding/Moving Boards in Windows 2000 and XP. 

http://www.ospreyvideo.com/
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Scenario 2:  Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options: 

Option A: Run the Installation Program (Recommended) 

Option B: Use the New Hardware Found Wizard (Not Recommended) 

Option A: Run the Installation Program (Recommended) 

When Windows XP is first started for the first time after the Osprey card is installed, 
the New Hardware Found wizard displays one or more times. Cancel out of these 
wizards. After Windows XP has finished starting, perform the following steps. 

To install the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WINXP directory. 

3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 
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4. Click Next. 

The Software License Agreement window displays. 

 

5. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 
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6. Click the radio button to select the default signal format.  See Video Standard 
for more information about signal formats. 

7. Click Next. 

The Information window displays. 

 

8. Click Next. 

The Choose Destination Location window displays. 
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9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Select Program Folder window displays. 

 

10. Click Next. 

The Start Copying Files window displays. 
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11. Click Next. Skip to Step 13 if you are installing the POST-WHQL driver version.

The Hardware Installation window displays. 

 

12. Click Continue Anyway. 

The Hardware Installation window displays. 

 

13. Click Continue Anyway. 

The files begin copying to the computer. 

 

The ViewCast Corporation/Osprey Video Division Special Offers Shortcut 
window displays. 
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14. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

15. Click OK to continue the installation. 

The Ligos Indeo Information window displays. 

 

16. Click Next. 

The Product Registration window displays. 
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17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

18. Click Finish to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

Option B: Use the New Hardware Found Wizard (Not 
Recommended)  

This method is more complicated than Option A. It is particularly inconvenient if you 
are installing multiple cards at once, since each card has to be set up separately. 

When Windows XP starts, it detects the new card(s) and starts the New Hardware 
Found wizard. 

 

NOTE: For all Bt/Ct878-based Osprey cards, the Wizard detects two 
logical devices for each card - a Multimedia Video Controller device and a 
Multimedia Audio Controller device. The Multimedia Video Controller is the 
video section of the Bt/Ct878 device; the Multimedia Audio Controller is 
the audio section. The audio logical device is present even on Osprey-100 
and Osprey-101 cards that have video or power connectors in place of the 
audio inputs. 

http://www.ospreyvideo.com/
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When the Hardware Wizard detects a device: 

 

Please note the terminology in the Add Hardware Wizard. It displays 
either Multimedia Video Controller or Multimedia Controller (the audio 
device). 

The Add New Hardware Wizard detects several new devices. Among these are the 
following: 

♦ Osprey Video Capture Device 

♦ Osprey Audio Capture Device (for Osprey-200 installations) 

♦ Osprey Function 1 Placeholder (for Osprey-100 and Osprey-101 installations) 

The Add Hardware Wizard window displays. 

 

1. Click Next. 

The Found New Hardware Wizard window displays. 
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2. Click to select Install from a list or specific location. 

3. Click Next. 

The Found New Hardware Wizard window displays. 

 

4. Click to select Don't search. 

5. Click Next. 

The Found New Hardware Wizard window displays. 
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6. Click to select Osprey Video Capture Device. 

7. Click Have Disk. 

The Install from Disk window displays. 

 

8. Click Browse and navigate to the location of the Osprey drivers. 

9. Click OK. 

The Found New Hardware Wizard window displays. 

 

10. Click Next. 

The Hardware Installation window displays. 
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11. Click Continue Anyway. 

The Found New Hardware Wizard window displays. 

 

12. Click Finish. 

13. Repeat steps 5 to 12 for the audio portion of the Osprey driver. 

 

After completing the Add Hardware Wizard, the application portion of the 
Osprey driver must also be installed.  To do this, navigate to the setup 
program for Windows XP and click SETUP.EXE.  For detailed steps, please 
refer to Option A: Run the Installation Program (Recommended). 
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Testing the Installation  

1. Verify the hardware installation is complete, in accordance with the directions in 
Chapter 2. 

2. Connect a camera, VCR, or other video signal source to the Osprey card’s 
connectors. 

3. Open the Osprey Multimedia Capture group in the Start menu. 

4. Click the VidCap32 icon. 

5. Verify the screen displays a still video frame from the Osprey-100 board. Click 
the Preview or Overlay button. The screen should display moving video 
frames. 

6. If the video area is a plain blue field, it could be for one of the following 
reasons: 

a. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector, or reconfigure the driver using 
its Control Dialog (refer to Chapter 6 - Capturing Video). 

b. The video source is not turned on or activated. 

7. If the video area is scrambled or has bad color, the signal format of your video 
source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL and SECAM 
equipment always need to change the driver’s signal format the first time they 
run the driver. Please see Video Standard in Chapter 6 - Capturing Video.  

Uninstalling the Software  

If you ever need to remove the Osprey driver from your system, proceed as follows: 

1. Open the Control Panel. 

2. Double-click Add/Remove Programs. 

3. Click to select Change or Remove Programs. 

4. Highlight the Osprey Multimedia Capture Driver entry. 

5. Click Change/Remove in the Osprey entry. 

The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete.  

8. Reboot your computer to complete the uninstall process. 
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Chapter 5 - Installing the Software - 
Windows NT 4.0 

The Osprey Capture Card products contains a single CD for Windows 2000, Windows 
XP, Windows NT 4.0 and Windows 95/98. The Windows 95/98 driver is an entirely 
separate driver that is not covered by this User's Guide. 

After you’ve installed the software, you can test the card and software by running 
the included application program, VidCap32. 

 

Please note: 

♦ Administrative privileges are required for installation. 

♦ Before installing software, check the ViewCast.com support 
website or the ftp site for the any driver update releases 
subsequent to the software shipped on your CD. For the 
ViewCast.com support website, go to 
http://www.ospreyvideo.com/ > Downloads > Software and 
Drivers.  Select the operating system and card type. To reach the 
ViewCast.com ftp site, go to ftp://ftp.viewcast.com/pub/OSP-
220/winnt/latest. It's a good idea to check these sites 
periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what appear on your computer screen. In some cases, 
version numbers and other minor differences may appear in the 
installation you are running. 

If you have not installed Microsoft's DirectX Media package, it is required 
to run the Windows Media Encoder Version 7 software.  The DirectX Media 
package is included on your Osprey Multimedia CD-ROM. 

If you already have the Osprey driver software installed on your system 
and are updating it, you do not have to remove the old version before 
installing the new version. The installation program removes or replaces 
any files or registry settings that are outdated. 

Installing from CD 

Downloading and Installing Updated Drivers 

Setup Program: Details 

Installing Ligos Technology's Indeo 

Testing the Installation 

Uninstalling the Software 

http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest
ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest
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Installing from CD  

1. If necessary, follow the directions in Chapter 2 to install the Osprey card. The 
software installation procedure will not work properly unless the card is already 
installed. Turn on the machine and start Windows NT. 

2. If you are updating from a previous version of the driver, it is not necessary to 
uninstall the old driver before installing the new driver. 

3. Insert the Osprey Multimedia Capture Driver CD into your CDROM drive. The 
installation instructions will assume this is the "D:" drive. Substitute the proper 
drive name as it appears on your system where appropriate. 

4. Run the installation program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter D:\WinNT\Setup in the dialog box. 

d. Click OK. 

5. The installation program will guide you through the installation steps. For many 
users it will be self-explanatory. If anything is unclear, refer to the section 
below entitled Setup Program: Details. 

6. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest you test 
the driver immediately. Refer to the section below entitled Testing the 
Installation.  

Downloading and Installing Updated 
Drivers  

1. Install the Osprey board in the PC, if you have not already done so. Turn on the 
machine and start Windows NT. 

2. The latest software drivers for Osprey Multimedia Capture Cards are available 
via FTP (file transfer protocol), at the following location: 

ftp://ftp.viewcast.com/pub/OSP-100/winnt/latest 

There are also links to the drivers from our web site, 
http://www.ospreyvideo.com/ 

The download image will contain a copy of the latest version of this User's 
Guide in Adobe PDF format. 

3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com/ - and then click on the list of directories that will 
appear until you have reached the ...winnt/latest location. Refer to your 
browser’s help files for more specific and detailed assistance. 

4. Download the setup file in ...winnt/latest to your hard disk. 

ftp://ftp.viewcast.com/pub/OSP-100/winnt/latest
http://www.ospreyvideo.com/
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5. Run the setup program: 

a. Click the Start button. 

b. Click Run.... 

c. Enter <pathname> in the dialog box, where <pathname> is the location 
and name of the file that you have downloaded. 

d. Click OK. 

6. The setup program will guide you through the installation steps. For many 
users it will be self-explanatory. If anything is unclear, refer to the section 
below entitled Setup Program: Details. 

7. The driver and demo programs are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest you test 
the driver immediately. Refer to Testing the Installation in Chapter 3. 

Setup Program: Details 

Setup Program: Details  

The setup program presents a sequence of windows and dialogs to guide you 
through the setup process. In general, click the Next > button to continue to the 
next screen. At any point you can click < Back to return to a previous screen or 
Cancel to exit the installation. 

The installation of the Osprey Multimedia Driver for Windows NT begins with a 
confirmation that the setup program is beginning. 

The Welcome window displays. 
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1. Click Next. 

The Information window displays. 

 

2. Click Next. 

The Software License Agreement window displays. 
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3. Review this message and make sure that the licensing terms are acceptable. 
Click Yes to accept the agreement. If you do not wish to accept the agreement, 
click No to terminate the installation routine. 

The Setup Type window displays. 

 

4. This window allows you to select the installation type. If you have any 
combination of Osprey cards which includes at least one Osprey-200 card, 
choose the Osprey-200/210/220 setup. If you have any combination of Osprey-
100, Osprey-50CPI and Osprey-101 cards, choose the Osprey-100 setup type. 
Choose the Custom setup if you want more control over the installation. You 
will then be prompted to select which components to install. 

The Osprey-100 and Osprey-200 setup types automatically install the third-
party applications Ligos Indeo and DirectX Media. The option of not installing 
these third-party applications comes only with the Custom setup type. Make 
your setup type selection and click Next. 

The Select Components window displays. 
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5. This window displays a list of choices for the default video signal format used in 
your country.  Select the Video signal standard you wish to use and click Next. 
For more information about video signal formats, see Video Standard. 

The Choose Destination Location window displays. 

 

6. The destination location is the folder where `VidCap32 (the demo applet), 
ReadMe, and other auxiliary files are located. (The core video capture driver 
files are located in Windows NT system directories regardless of the destination 
location chosen here.) The default location, in the Program Files folder, should 
be appropriate for most systems. If you install the Windows 2000, Windows XP, 
Windows NT and Windows 95/98 versions, you can place them in the same 
directory, and you can save a small amount of disk space by doing so. Click the 
Browse button near the bottom of the dialog if you want to change the 
location. 

The Select Program Folder window displays. 
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7. The setup program suggests placing the Osprey icons in a new program folder 
entitled “Osprey MultiMedia Capture.” You can change this name by editing the 
Program Folders field, or you can add the icons to an existing folder by 
highlighting it in the Existing Folders window. Click Next to continue. 

The Start Copying Files window displays. 

 

8. Click Next. 

The Ligos® Indeo® Information window displays. 
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9. Click Next. 

The DirectX® Information window displays. 

 

10. Click Back to modify the directory and program folder destinations or click 
Next to continue. The installation program copies the files to their destinations, 
sets up the Osprey driver registry entries, and starts the driver. 

A question dialog window displays. 

 

11. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 

A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 
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12. Click OK to continue the installation. 

If another kind of video capture driver is already installed on your system, 
another question dialog window displays. 

 

13. Click Yes to make the Osprey driver your primary video capture driver, unless 
you have a particular reason for doing otherwise. Refer to Appendix D - Using 
the Osprey Video Capture Driver with Other Drivers for more detailed 
information about this message. 

If another kind of audio capture device such as a soundcard is already installed 
on your system, a message similar to the one above displays asking, “Do you 
want to make this your primary audio capture driver?” 

 

14. Click Yes to use the Osprey-210/220 as the primary audio capture device. 

The Product Registration window displays. 

 

15. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 

A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

http://www.ospreyvideo.com/
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The Setup Complete window displays. 

 

16. Click Finish. 

 

If you have an Osprey-100, -101, or -50 card, the driver is ready to test 
and use. 

 

If you have an Osprey-200 card, you must restart Windows NT in order to 
use the audio capture feature. Normally, the installation program 
recommends a restart if one is needed, based on the type of card you 
have present. 

However, if you are updating from driver version 1.33 or earlier to driver 
version 1.35 or later, you will have to restart Windows NT after the 
installation. Normally the installation program will detect this condition 
and recommend the restart if it is needed. 

Installing Ligos Technology's Indeo 

This procedure is the same regardless of the computer's operating system. See 
Installing Ligos Technology’s Indeo in Chapter 3. For detailed instructions, 
please refer to the Ligos Technology’s Indeo section in Chapter 8 - VidCap32, 
AmCap, Control Panel, Cropping & Scaling and Indeo. 

Testing the Installation 

Refer to Testing the Installation in Chapter 3 for full details.  
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Uninstalling the Software  

If you ever need to remove the Osprey driver from your system, proceed as follows: 

1. Open Control Panel. 

2. Double-click Add/Remove Programs. 

3. Click the Install/Uninstall tab. 

4. Click to select the Osprey Multimedia Capture Driver in the list of programs. 

5. Click Add/Remove.... 

The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete. 

 

NOTE: You have the option of deactivating the Osprey drivers without 
permanently uninstalling them. This allows you, for example, to use another 
device as your primary video capture device. Refer to Appendix D - Using 
the Osprey Video Capture Driver with Other Drivers for more 
information. 

 



Chapter 5 - Installing the Software - Windows NT 4.0 

100 -- Osprey Multimedia User's Guide Version 2.2.0 ViewCast Corporation 

 



 Chapter 6 – Video Control Dialog 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 101 

Chapter 6 – Video Control Dialog 

The easiest way to familiarize yourself with the video capture capabilities of the 
Osprey cards and video capture driver is run the included capture application 
VidCap32 and look at its menus and dialogs. VidCap32 is described in detail in 
Chapter 8. This chapter focuses on the underlying video capture driver – in 
particular its control dialogs that you can access from VidCap32 and similar video 
applications. 

The Osprey video capture driver has a unified tabbed dialog for setting up all driver 
parameters. 

 

There are seven pages within the dialog: Source, Format, Closed Caption, Logo, 
Advanced Features, Configuration, and SimulStream. 

Accessing the Dialog 

General Features of the Dialog 

The Source Page 

The Format Page 

The Closed Caption Page 

The Logo Page 

The Advanced Features Page 

The Configuration Page 

SimulStream Page 
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Accessing the Dialog 

The normal way to access the dialog is through a menu entry or control button 
belonging to the application program. For example, VidCap32, has three menu 
entries - Options-> Source..., Options -> Format..., and Options -> Display... 
that access respectively the Source, Format, and Closed Caption pages of the dialog. 
Once you are in the dialog, you can move to any other page by clicking on its tab. 

Another way to access the Configuration page is through the Control Panel.  

Instructions for Windows NT 4.0 

Instructions for Windows XP 

Instructions for Windows 2000 

You can open the dialog through the Control Panel at the same time another 
application is accessing the card. This is useful if the application does not provide an 
access control to the dialog. When you open the dialog through the Control Panel, 
some changes such as adjustments to brightness, contrast, etc. display immediately. 
Others will not take effect until the application is restarted.  

Instructions for Windows NT 4.0  

1. Open My Computer -> Control Panel -> Multimedia. 

2. Select the Devices tab. 

3. Open Video Capture Devices. 

4. Highlight Osprey Video Capture Driver. 

5. Click Properties. 

6. Click Settings.... 

Instructions for Windows XP  

1. Open My Computer -> Control Panel -> Sound, Speech, and Audio 
Devices. 

2. Click Sounds and Audio Devices. 

3. Click the Hardware tab. 

4. Select Legacy Video Capture Devices. 

5. Click Properties. 

6. Click the Properties tab. 

7. Select Osprey Video Capture Driver. 

8. Click Properties. 

9. Click Settings. 
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Instructions for Windows 2000  

1. Open My Computer -> Control Panel  -> Sounds and Multimedia. 

2. Select the Hardware tab. 

3. Double-click Legacy Video Capture Devices. 

4. Click the Properties tab. 

5. Select Osprey Video Capture Driver. 

6. Click Properties. 

7. Click Settings. 

General Features of the Dialog 

These are the common elements found on all pages of the dialog.  

 

Source, Format, Closed Caption, Logo, Advanced Features, Configuration, 
SimulStream 

OK 

Cancel 

Restore Defaults 

Restore Previous 

Help 
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Source, Format, Closed Caption, Logo, Advanced Features, 
Configuration, SimulStream 

These are the “Tabs” of the dialog that access different controls. Click on the tab to 
access that portion of the dialog. The contents of each tab are described in the 
following sections. 

By default, the Format tab is only shown when you access the Format page directly 
from the application. This is to ensure maximum compatibility with Video for 
Windows applications. You can make the Format tab available from any other page 
by a button on the Configuration page, as explained below.  

OK 

The OK button exits the dialog, saving the settings you have currently chosen. If you 
have made changes on two or more pages of the dialog, or for two or more boards, 
all of these changes will be saved.  

Cancel 

This button exits the dialog box without saving any changes. If you have made 
changes on two or more pages of the dialog, or for two or more boards, all of these 
changes will be discarded.  

Restore Defaults 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were when the Osprey software was installed.  

Restore Previous 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were at the start of the previous dialog session.  

Help 

Clicking Help accesses the pages of this manual covering the currently selected tab. 
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The Source Page 

 

Use the Source page to set the characteristics of the input video. 

Input 

Video Standard 

Video Settings 

Input 

The Input field has buttons for the card’s Composite and S-Video input connectors. 

If Preview or Overlay mode is enabled in your application, you will usually be able to 
see the results of your selection immediately, without exiting the dialog. However, if 
you switch between inputs that have two different signal formats, such as NTSC or 
PAL, the video will not display correctly until you exit the dialog.  

Video Standard 

Video Standard refers to whether the video signal format is NTSC, PAL, or SECAM. 
Depending on the exact product version you have, you will see buttons for some or 
all of the following formats: 
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♦ NTSC-M – North America 

♦ NTSC-J – Japan 

♦ PAL-B, D, G, H, I – many countries in Europe and elsewhere. B, D, G, H, and I 
refer to five nearly identical subformats. 

♦ PAL-M – Brazil 

♦ PAL-N, NC – Argentina, Paraguay, Uruguay 

♦ SECAM – France and some other countries 

Full-sized NTSC-M, NTSC-J, and PAL-M have 525 lines total, 480 lines visible, per 
frame and a display rate of 60 fields per second, or 30 interlaced frames per second. 

Full-sized PAL (other than PAL-M) and SECAM have 625 lines total, 576 lines visible, 
per frame and a display rate of 50 fields per second, or 25 interlaced frames per 
second. 

The standard frame sizes are different for NTSC and PAL. For example, the half-
frame size in pixels is 320x240 for NTSC, and 384x288 for PAL. If you have selected 
a standard frame size (Full, 1/2, 3/8, or 1/4), the driver will automatically adjust the 
frame size to correspond to the standard. If you have created a custom size, it does 
not change when you switch between NTSC and PAL/SECAM. 

Changes to the signal controls do not take effect until you exit the dialog.  

Video Settings 

These four slide controls set Brightness, Contrast, Hue, and Saturation. These 
settings are stored separately for each video source. 

NOTE: When using these controls, be sure that the preview mode or overlay mode is 
enabled, so that you can immediately see the effects of your changes. 

When a video source with PAL or SECAM signal format is used, the Hue setting is not 
adjustable and the Hue control is grayed out. 

The Restore Previous or Restore Defaults button can be used to restore the previous 
video settings.  
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The Format Page 

Two different versions of the Format Page display, depending on whether or not 
Enable Cropping is selected. 

 

 

Use the Format page to set the color format and size of the image.  See Cropping 
and Scaling for information on this feature. 

Color Format 

Video Size 

Custom Size 

Proportions (Pixel Aspect Ratio) 
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Cropping and Scaling (please see the CropApp Manual for detailed instructions 
on using this feature) 

Color Format 

The Color Format is the arrangement of data bits representing the colors of each 
pixel. For example, in the Rgb15 format, each pixel of data is stored as 5 bits of red, 
5 bits of green, and 5 bits of blue color information. 

Video delivered by the Osprey board to the system is in uncompressed format. It is 
possible to compress the video as a subsequent stage of processing. However, this 
dialog field refers specifically to the uncompressed raw video that the board delivers 
to the system. 

The color format you choose applies to Capture video and to Preview video. It does 
not apply to Overlay video. Overlay video is always matched to the display adapter’s 
current screen format - except when grayscale mode is selected. Overlay video is 
therefore as fast and efficient as possible, but the color rendering may differ very 
slightly from what you will capture. Preview mode renders colors exactly, but it is 
slower and consumes more system resources. 

Changes to Color Format take effect only after you exit the dialog. 

For a more detailed description of the color modes available, refer to Appendix B: 
Color Modes.  

Video Size 

The Video Size field allows you to select between the various sizes given below. 
Changes made to Video Size take effect only after you exit the dialog. 

Size Width x Height Also known as: 

Full 640x480 Full 

1/2 320x240 CIF 

3/8 240x180 Full 

1/4 160x120 QCIF 

The width and height shown are in pixels for the North American NTSC-M video 
format. For further details, refer to Appendix C: Video Sizes. 

There is a fifth button, Custom, that becomes selected whenever a non-standard size 
is entered in the Custom Size field, described below.  
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Custom Size 

The Custom Size field allows you to set widths and height different from the standard 
preset values of full, 1/2, 3/8, and 1/4. 

There is a checkbox marked Fixed Ratio. If this box is checked, when you enter a 
size in the height box, the width is automatically adjusted to maintain the normal 
screen proportions; and vice versa. If this box is unchecked, the height and width 
may be entered independently. If the dimensions are different from normal screen 
proportions, the image will be stretched horizontally or vertically. 

The Osprey video hardware is not capable of drawing all possible widths. Depending 
on the color mode selected, it may require a width that is an even number of pixels, 
or (for YVU9 and YVU12) a width that is a multiple of 16. The dialog will let you enter 
numbers that the hardware cannot utilize, but will adjust them as soon as you click 
on another field or button of the dialog.  

Proportions (Pixel Aspect Ratio) 

This dialog allows you to select between “Standard” and “CCIR601” proportions. 

The Standard setting results delivers square pixels on a standard dedicated monitor 
that has a normal aspect ratio (ratio of height to width). 

CCIR601 results in a full-screen line length of 720 pixels in both NTSC and 
PAL/SECAM modes. In the NTSC format, the video when viewed on a standard 
monitor will have narrower than square pixels. In PAL/SECAM format, it will have 
wider than square pixels. When viewed in a video window on your main screen, the 
pixels will be square, but the aspect ratio of the frame as a whole will be different 
from the standard – wider for NTSC, narrower for PAL/SECAM.  

Cropping and Scaling 

Please see Cropping and Scaling in this chapter and the CropApp Manual for 
detailed instructions on this feature. 
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The Closed Caption Page 

 

Use the Closed Caption page to enable or disable Closed Captioning, and to control 
its characteristics. 

Display on Screen 

Save to File 

Mode 

Channel 

Text Color 

Apply Changes to all Boards 

Closed Captioning is a method of encoding and displaying text such as movie dialog 
captions and stock quotes as part of NTSC video. The text is similar to movie 
subtitles in appearance. Closed Captioning is widely available on broadcast video, 
cable, videotapes, and videodisks. 

The Osprey Video Capture Driver provides a complete implementation of the Closed 
Captioning standard, and also provides special extensions that are made possible by 
the special capabilities of a PC. 



 Chapter 6 – Video Control Dialog 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 111 

You can use Closed Captioning whenever you can meet the following conditions: 

♦ You must be viewing a videotape, videodisk, or broadcast material that has 
Closed Captioning content. There will be a small “CC” logo on the packaging 
or in the program listing. 

♦ Closed Captioning is for North American NTSC video only, not for PAL or 
SECAM video. 

♦ Closed Captioning must be enabled in the Osprey driver, using the Closed 
Caption dialog page as explained below. 

♦ Video Mode, and Channel 1 must normally be selected, as explained below. 
You might use Text Mode or Channel 2 in specialized instances. 

In addition to the normal options of viewing or capturing Closed Captioning, you 
have the following special capabilities: 

♦ You can save the text to file as you view it or capture it. 

♦ If you are a software developer you can write a Video for Windows application 
that receives decoded Closed Captioning text from the Osprey driver and 
searches it or processes it in any way you see fit. Contact 
mailto:support@ospreyvideo.com for more information about this 
capability. 

Display on Screen 

The Enable checkbox enables display of Closed Captioning on the screen if it is 
checked and disables it if it is unchecked. 

If you check or uncheck the Enable checkbox while Overlay or Capture mode is in 
effect, the change will not take effect until Overlay or Capture is stopped and 
restarted. 

It is recommended that you disable Closed Captioning when using non-Closed 
Captioned video. If you leave Closed Captioning enabled, the software will attempt to 
interpret regular video as Closed Captioning character codes, and may sometimes 
display spurious characters. It will also slightly increase the driver’s CPU usage. 

The normal display mode is Over Video. In this mode the Closed Captioning is 
superimposed on the video field. 

The Own Window option is a special proprietary mode for Closed Caption display. A 
separate window appears, and the text scrolls up in this window instead of appearing 
on the video field. This window disappears while you are capturing video and 
reappears after capturing video. This mode may be useful for some kinds of material, 
as the lines of text are not erased as quickly. The Own Window option, however, 
does not fully conform to Closed Caption standards, especially with regard to line 
placement. It may therefore give undesirable results with some kinds of highly 
formatted captions.  

mailto:support@osprey.viewcast.com
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Save to File 

A nice feature of Closed Captioning on a PC is that you can save the captions to a file 
for later review. The Save to File field contains three controls: 

♦ The Enable checkbox if checked enables saving to a file. 

♦ The Edit Box allows you to type in the name of the file that you want to save 
the captions to. 

♦ The Browse... button accesses a standard system dialog for searching for a 
directory and file to save to. When you choose a file that already exists 
(either by the Browse... button or by specifying it directly), new captions will 
be appended to whatever was previously in the file. 

You can enable saving to a file without enabling display of Closed Captioning on the 
screen – the two checkboxes are independent.  

 

When SimulStream is in use, only one closed caption session can be 
saved to a file. 

Mode 

Video is the normal Closed Captioning display mode used with almost all videos and 
broadcast TV. Text is a specialized mode in which the entire 32 character by 15 row 
Closed Captioning area of the screen is blanked and used to display text. Use Video 
mode unless you know specifically that the material is Text mode.  

Channel 

Channel 1 is the channel normally used in almost all Closed Captioning. Some 
specialized material may use Channel 2. Note that if you select Channel 2 you 
won’t see any Closed Captions with most material.  

Text Color 

Select the color in which you want the closed captioned text to display.  

Apply Changes to all Boards 

If multiple boards are present, an additional option to Apply changes to all boards 
rather than just the one currently selected appears when closed captioning is 
enabled. 
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The Logo Page 

 

 

The Osprey Video Capture Driver allows you to superimpose a logo on captured 
video, as in the illustrations below. The “VCST” logos shown illustrate some of the 
features for color keying and translucency that will be described below. 

Use the setup dialog’s Logo page to set up a logo. The logo “page” is actually a 
sequence of five pages that guide you through the steps of creating a logo and 
placing it on the video. 

You cannot access the Logo page directly from VidCap32 or similar application. 
Instead, open the Source or Format page of the dialog, then click on the Logo tab. 
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Capabilities 

Step 0 - Before You Start 

Step 1 - Creating and Enabling the Logo 

Step 2 - Selecting the Logo File 

Step 3 - Setting Key Color and Style 

Step 4 - Positioning the Logo 

Step 5 - Reviewing and Saving the Changes 

Notes on Logos 

Capabilities 

A logo can be any artwork that is formatted as a 24-bit .BMP file. Typically a logo is a 
small graphic that is placed at the lower left of the image. In a technical application, 
however, a logo could be, for example, a crosshair pattern placed at the center of 
the image. The logo can theoretically be any size. However, the CPU must actively 
draw the image on every frame of video, and drawing a very large image, even if it 
is mostly transparent, will degrade overall performance in high-throughput 
applications. 

The driver can draw a logo on captured or streaming video, on preview video, or on 
DibDraw overlays. It cannot, however draw a logo on DirectDraw overlays – if you 
attempt to do so, everything will work fine, except that the logo will not be visible. 

A logo’s rectangle can be partially transparent so that the underlying video is visible. 
The transparent areas are defined by a key color – a particular (red, green, blue) 
value that is specially interpreted by the driver. For example, the sample logos use 
cyan with red, green and blue values of (0, 128, 128) as the key color. 

A logo can be displayed in either of two styles – normal and embossed. In normal 
style, the logo’s non-transparent pixels simply replace whatever video underlies it. In 
embossed or translucent style, the logos non-transparent pixels are averaged with 
the underlying video pixels, resulting in a more subtle effect. 

Here are the detailed steps for setting up a logo: 

Step 0 - Before You Start 



 Chapter 6 – Video Control Dialog 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 115 

Step 0 - Before You Start 

Create your artwork with the Windows Paint accessory or any other paint program 
that you like to use. Save it in 24-bit .BMP format. 

Before creating your own logo, however, you may want to experiment with the 
samples supplied with the driver. They are located in the Osprey program directory, 
by default \Program Files\Osprey Multimedia Capture\Nt on the default drive. 

Have Preview or DibDraw Overlay mode running when you enter the dialog. If you do 
so you will be able to see immediately the results of interactively defining and 
placing the logo. DirectDraw Overlay mode does not work for this purpose. To 
change from DirectDraw to DibDraw – or to find out which you are currently using – 
go to the dialog’s Configuration tab, then stop and restart Overlay mode. 

Step 1 - Creating and Enabling the Logo 

Additional links: 

The Logo Page 

Capabilities 

Step 1 - Creating and Enabling the Logo 

 

As you can see, the logo setup pages include explanations at each step. Hopefully 
the details will be largely self-explanatory. 

The first page handles only one consideration – whether logo drawing is enabled or 
not. 
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By default, the Enable box is not checked and therefore no logo will be displayed. In 
this case, when you click Next>> you go directly to the last page (page 5) of the 
logo setup sequence. 

If the Enable box is checked, when you click Next>> you will step through all of 
the pages of the setup sequence. 

Step 2 - Selecting the Logo File 

Additional links: 

The Logo Page 

Capabilities 

Step 2 - Selecting the Logo File 
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This sheet should be nearly self-explanatory. You are selecting a .BMP file, either 
your own artwork or one of the samples. You can either type in the full pathname to 
the file, or browse for it. When you have selected the file, click Next>>. 

The sample logos are located in the Osprey program directory, by default \Program 
Files\Osprey Multimedia Capture\Nt on the default drive. 

Step 3 - Setting Key Color and Style 

Additional links: 

The Logo Page 

Capabilities 

Review Step 1 

Step 3 - Setting Key Color and Style 

 

As previously noted, a “key color” is a (red, green, blue) color value that the driver 
treats specially. Logo pixels in that color will not be displayed; instead the underlying 
video will appear. This dialog sheet lets you choose one of four fixed key colors, or 
no key color. If you select None for the key color, all pixels from the logo will be 
displayed including all pixels in any of the key colors. 

A key color must be a precise (red, green, blue) value. For example, if cyan is 
selected as a key color the pixel values must be exactly (0, 128, 128). A pixel of 
value (0, 127, 127) will be not be transparent – it will display as cyan. 

All four key colors are standard stock colors in Windows Paint. 
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If the Embossed box is checked, each pixel color value displayed will be the average 
of the pixel value of the logo and the pixel value of the underlying video. If 
Embossed is not checked, the pixel color value will simply be the value from the 
logo. 

The key color setting takes precedence over the Embossed setting – that is, logo 
pixels in the key color will be transparent, not averaged, even in Embossed style. 

Step 4 - Positioning the Logo 

Additional links: 

The Logo Page 

Capabilities 

Review Step 2 

Step 4 - Positioning the Logo 

 

The Position control allows you to position the logo by dragging it with the mouse. 
The Nudge controls move the logo up, down, left or right one pixel at a time. They 
permit more precise adjustments than the Position control can achieve. 

If Preview or DibDraw Overlay video is running, you will see the logo move on the 
video as you move it in the dialog. 

If you position the logo in a certain way and then change the video size, the driver 
will stretch the logo to maintain the same relative size, and will place it in the same 
relative position. The stretched artwork may have jagged diagonal edges and will not 
look as good as unstretched artwork prepared with the intended video size in mind. 

Step 5 - Reviewing and Saving the Changes 
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Additional links: 

The Logo Page 

Capabilities 

Review Step 3 

Step 5 - Reviewing and Saving the Changes 

Additional links: 

The Logo Page 

Capabilities 

 

This page shows a text summary of the current logo configuration. 

If you have multiple boards in the system, a checkbox entitled Apply to all Boards 
appears, as illustrated in the following screen. If you check Apply to all Boards, the 
logo changes you make to the current board are made to all the boards in the 
system. 

 

If you have multiple boards in the system and the only change you make 
is to enable or disable logos, clicking OK with Apply to All Boards checked 
changes the enable/disable status of all boards but doesn't change any of 
the other settings.  

If, however, you make any logo changes other than enable or disable, 
Apply to All Boards copies the entire current configuration to all boards. 
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Notes on Logos  

If you set up a logo with video set to one size, then resize video, the logo is scaled 
correspondingly. For example, if the logo is originally set up for 320x240 video, and 
you change to 640x480 video, the logo will now display at twice the size of the 
original bitmap. 

1. If you edit the logo settings while the logo is scaled up or down,, you will see 
an additional option, Rescale. It will be the second page in the sequence, after 
Enable. 

 

If you click the Rescale button on this page, the logo will be resized to the same 
size as the original source bitmap. 

If you do not click the Rescale button, you can edit the logo settings using the 
scaled logo. Even if you change to another bitmap image, the old scaling will be 
maintained. 

2. The driver can display color logos on YUV video – 4:2:2 packed, YUV12 planar, 
and YVU9 planar. The appearance may not be quite the same as the RGB 
version, however. 

Detail of colored features may not be as crisp, because in the YUV modes color 
is not sampled at full pixel resolution. 

 

NOTE: DibDraw Overlay video is always RGB even when you have selected a 
YUV color format in the dialog. Preview video is always in the exact YUV or 
RGB format you have selected. Therefore, when using a YUV mode be sure to 
check the appearance of the logo in Preview mode before putting it to use. 

3. When Grey8 video format is selected, all logos including color logos are 
displayed in greyscale.  



 Chapter 6 – Video Control Dialog 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 121 

Advanced Features 

Select a link below the screen for more information. 

 

Field Order 

The De-Interlacing Motion Filter 

Field Order 

The Osprey Video Capture Driver allows you to configure which pairing of fields will 
be used to construct a frame.  For interlaced capture devices (most current video 
cameras) the field order does not matter and the 'Allow Either' setting will provide 
better performance in VFW preview mode. The default setting for this feature is 
'Allow Either'.  Use the force odd-even or force even-odd settings with a progressive 
scan camera.  Consult your camera's technical documentation for the correct setting 
to use.  Using the correct setting with a progressive scan camera will eliminate 
comb-like interlacing artifacts. 

The De-Interlacing Motion Filter 

The Osprey Video Capture Driver offers software de-interlacing. This is optimized for 
Windows 2000 and later; it consumes fractionally more CPU cycles when enabled 
under Windows NT.  If you are using a progressive video source, do no turn on de-
interlacing. 
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Most video is provided for viewing in an interlaced format. For simplicity, NTSC is 
used in the following explanation of an interlaced format. NTSC video is basically 
composed of images taken 60 times a second. Each image is called a field, and there 
are odd and even fields. While these odd and even fields are temporarily adjacent to 
each other in time, the horizontal lines that make up these fields are spatially 
different. 

 

The figure above is a simplistic view of interlaced video and fields. The two fields are 
taken 1/60th of a second apart, and the lines of each field are not aligned, but 
staggered. Most televisions are interlace display devices, where the 60 fields are 
displayed individually and the viewer sees only one field at a time. However, most 
computer monitors are progressive and not interlaced display devices. On a 
computer monitor where video is viewed at its full resolution, viewers see both the 
odd and even fields at once: 

 

The problem with progressive display devices is that if an object is moving, its 
position is not the same in both the odd and even fields. When odd and even fields 
are merged together, interlaced artifacts occurs. The artifacts are seen and 
commonly described as streaking or feathering. 
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The screen above illustrates the streaking or feathering problem that occurred when 
the interlaced odd and even fields in this video were captured. Only a slight amount 
of motion took place, yet streaking is obvious in the overall result. Note the 
prominent horizontal lines outlining all the objects on this screen. 

When feeding such images to an encoder, the encoder has a significantly harder time 
processing and compressing such interlaced video. The result is loss of overall quality 
and perhaps a loss of frame rate as well. While the encoding process may smooth 
out some of these artifacts, the resultant compressed video may still display 
somewhat streaked or feathered and may not play back smoothly. 
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The Osprey Video Capture Driver's de-interlacing motion filter can be applied to any 
video source prior to the optional scale and color-convert phases of processing to 
eliminate streaking or feathering and maintain motion content. In the screen above, 
where the Osprey Video Capture Driver's de-interlace motion filter has been turned 
on, note that the strong horizontal streaking or feathering around the subject’s head 
have been smoothed to a slight blur. While the blur is noticeable in a single screen 
snapshot, the human eye perceives only natural motion when the video is played 
back at normal frame rates. 

Feeding the de-interlaced image in the screen above to an encoder significantly 
improves output of the encoder in terms of overall quality and smoothness. The 
encoder has an easier time compressing the de-interlaced video and thus can expend 
saved bits and CPU cycles to produce higher quality streams.  
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The Configuration Page 

 

Overlays 

Access to Format Tab 

Multiple Opens 

Default Capture Device 

Overlays   

Direct Draw is a fast drawing method that moves video directly from the Osprey 
capture card to the display adapter. If Use Direct Draw is selected, the driver use 
Direct Draw for Overlay drawing. If for some reason it cannot use Direct Draw, it will 
automatically fall back to the default drawing mode (known as “DibDraw”). 

Direct Draw works with the vast majority of display adapters and software driver. We 
recommend running with Direct Draw enabled unless you are having a problem 
viewing overlay video, or want to use the “doubled lines” option discussed below. For 
more details on Direct Draw, refer to Appendix E: Direct Draw. 

DibDraw is the default drawing method. Video is moved first into system memory, 
then copied to the display adapter. It is useful in the following cases: 
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1. For systems where Direct Draw does not work correctly. 

2. If you want to enable “line doubling”. When DibDraw is selected, two radio 
buttons are enabled that let you choose between interlaced and line-doubled 
video. 

Normally, video larger than ½-height (240 lines NTSC, 288 lines PAL) is 
interlaced. NTSC and PAL video both consist of alternating odd and even fields 
of data. Odd numbered lines come from the odd fields, even numbered lines 
come from the even fields. 

Interlaced video offers maximum resolution but suffers from a “comb” effect: 
When there is rapid motion in the video, it appears blurred. It is recommended 
for still or slow-motion video, but may not look good with high-motion content. 

Line-doubled video uses video data from only one field. Each video line is 
copied to two lines of your display. Line-doubling reduces the still-picture 
resolution by half; however, it eliminates the “comb” effect of interlaced video 
and is therefore useful for viewing rapid-motion video. 

3. If you want to stretch the video on your screen beyond full size (640x480 
NTSC, 768x576 PAL). You would need a special application to do this. DibDraw 
video can be stretched but Direct Draw video cannot be.  

Access to Format Tab 

The two options are: 

♦ Prevent access to a dialog’s format tab via source dialog 

♦ Allow this access 

Video for Windows applications access the Source and Format pages as separate 
commands and do not assume that the driver allows you to switch from one to the 
other. 

Some applications, when they access the Source page, do not check to see if you 
also made changes to items in the Format page. The result is that the application 
and the driver may assume different settings and not work properly together. 

This control in its default “prevent access” setting prevents you from entering the 
Source page or Closed Caption page, switching to the Format page, and 
inadvertently making changes that the application will not pick up. It also disables 
the Board Select control on the Source and Closed Caption pages – since the driver 
maintains separate format information for different boards. The “prevent access” 
setting is recommended for maximum compatibility with all applications. 

The “prevent access” settings is, however, inconvenient. The alternative setting to 
“allow this access” allows you to switch between pages without restriction. This will 
work with many applications; however, the responsibility lies with you to make sure 
no problems arise.  
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Multiple Opens 

We recommend that you keep the Multiple Opens box checked unless you have a 
particular reason not to. This will ensure compatibility with the greatest number of 
present and future applications that you might want to use. 

If Multiple Opens is checked, a particular board can be opened for access from 
multiple places, either within a single process or by multiple processes. However, the 
features available through subsequent opens are limited. This mode is needed by 
certain complex applications that, for example, use separate processes for capture 
and overlay.  Multiple Opens should be checked when utilizing Windows Media 
Encoder. 

If Multiple Opens is unchecked (hunt mode), a particular board can be opened for 
access from only one place in one process. If there are multiple boards in the system 
and an application tries to access a board that is already in use, the driver hunts for 
the next available board. This is the easiest way to start multiple copies of some 
applications. 

Changes you make take effect when you click OK to close the dialog. Applications 
such as VidCap32 will not pick up changes until you restart them. 

Review Appendix F - Multiboard Installations for more information. 

Default Capture Device 

This control is useful if you have multiple video capture devices of different kinds. 
These could include cards from other vendors or different kinds of capture cards from 
Osprey. In this context, the Osprey-50, -100, -101, and -200 are considered one 
single device type. 

Some applications are capable of accessing only the primary or default device. With 
this control you can select which device will be the default that such an application 
will use. 

Changes you make are written to the registry when you click OK to close the dialog. 
Applications such as VidCap32 will not pick up changes until you restart them. Some 
DirectX-based applications may not detect changes until you restart the system.  
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The SimulStream Page 

SimulStream is an added-cost upgrade option described in detail in SimulStreaming 
User’s Guide. 

 

Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured.  Cropping is done by the 
Osprey card and imposes no extra load on the host computer.  Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 

♦ CropApp, the cropping application 

♦ SDK 

Please see the CropApp Manual which is installed in the Osprey MultiMedia Capture 
Program group for details on using this feature. 
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Chapter 7 - Capturing Audio 

The process of capturing audio is very similar for the Osprey-100/101 and the 
Osprey-200. For the Osprey-100/101, route your audio to the line or microphone 
input on your system sound card. For the Osprey-200, you can route your audio 
either to the system sound card or to the line inputs on the Osprey board. If you 
have multiple Osprey-200s, you can capture multiple streams of audio along with 
your video – something not possible with conventional sound cards. 

Setup and control for audio are much simpler than for video. That’s the good news. 
The bad news is that most applications handle audio setup in their own, non-
standard ways. What we’ll show here is mainly useful, therefore, for testing audio 
and as an example of what you will find. The methods shown work with the Sound 
Recorder applet included with Windows, and with VidCap32. 

There are three basic steps: 

♦ Selecting the audio source 

♦ Setting input volume 

♦ Selecting the audio format 

Also see Audio Playback. 

Selecting the Audio Source  

Audio source is set using a dialog in the Control Panel. There are two ways to get to 
this dialog: 

♦ Windows 2000 and Windows NT - click the Start button on the Start Menu, 
select the Control Panel, click the Sounds and Multimedia icon, and select 
the Audio tab: 

Start -> Settings -> Control Panel -> Sounds and Multimedia ->Audio 

♦ Windows XP - click Start and select Control Panel, then click Sounds, 
Speech and Audio Devices, then click Sounds and Audio Devices and 
select the Audio tab. 

♦ Or, right click the speaker symbol on your Start Menu, select Adjust Audio 
Properties, and select the Audio tab: 

 

Both these routes lead to the following system dialog: 
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If you have Osprey-200 card(s), you will see Osprey-200 Audio as one of the 
choices in the Sound Recording - Preferred Device drop-down box. The other choice 
you will usually see is your system sound card. The selection you make here will 
determine whether the audio you capture will be from your Osprey-200 card(s) or 
from your system sound card. 

If you have two or more Osprey-200 cards, and have selected Osprey-200 Audio, 
you can capture multiple separate audio streams, one through each card. If you 
select sound card audio, audio for all streams comes from the sound card. 

If you have Osprey-50, -100, or -101 card(s), you will not see the Osprey-200 
choice, and you have to route audio through the sound card’s line or microphone 
input. 

With Sound Recorder, you can access this dialog via the menu entry Edit -> Audio 
Properties. Note, however, that a change to the audio source will not take effect 
until you restart the application. 

Vidcap32 does not include a command to access this dialog from within the 
application.  



 Chapter 7 - Capturing Audio 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 131 

Setting Input Volume 

Click the Sound Recording Volume button in the Sounds and Multimedia Properties 
dialog: 

 

 

If you have selected Osprey-200 Audio, the Record Control screen will pop up. The 
volume and mute controls are operative for the Osprey-200; the balance control is 
not used. 
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If you have selected your system sound card audio rather than Osprey-200 audio, 
you will see a display that resembles the following: 

 

Note the checkboxes at the bottom that select which source is actually being used. 
Typically, you would select either the line input or the microphone input. The balance 
controls as well as volume controls are operative with the system sound card. 

It is recommended that you move the input volume slider to maximum volume when 
using the Osprey-200 as the audio device. 

 
NOTE: The quick-access volume control on the Start Menu controls playback 
volume, not recording volume. 

Setting Sound Format 

Sound format is selected from inside the multimedia application you are using. There 
is a standard system Sound Selection dialog box that some applications use, 
including VidCap32 and Sound Recorder. The means of selecting it will vary from 
application to application. For VidCap32, select the menu entry Options -> Audio 
Format.... For Sound Recorder, select the menu entry File -> Properties. In the 
Properties for Sound dialog that comes up, click the button Convert Now. 

The Sound Selection dialog box you see will look like this: 
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The only Format that the Osprey Audio Capture Driver supports is PCM. The driver 
supports the following data rates in the Attributes list: 

♦ 8kHz 

♦ 11.025 kHz, 

♦ 16 kHz 

♦ 22.05 kHz 

♦ 32 kHz 

♦ 44.1 kHz 

These data rates are supported in 8-bit and 16-bit, mono and stereo formats. The 
driver does not support the 48kHz format. 

These options range from telephone-quality mono up to CD-quality stereo. The 
corresponding data rates and storage requirements range from 7 to 172 kilobytes 
per second. In general, you will want to use the most compact format that provides 
sufficient sound quality for your application.  

Audio Playback 

The Osprey-200 provides audio capture only, not audio playback. Continue to play 
back captured audio using your system soundcard.  
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Chapter 8 - VidCap32, AmCap, Control 
Panel, Cropping & Scaling and Indeo 

VidCap32 

AmCap 

DirectX Media Details 

Control Panel 

Cropping and Scaling 

Ligos Technology Indeo 

VidCap32 

 

VidCap32 is a video capture application that is included with the Osprey package. It 
is useful for testing the installation, for general purpose viewing of video, and for 
capturing video to file. 

The following instructions take you through the basic scenarios for using this applet. 
VidCap32 has additional capabilities and settings that are beyond the scope of a brief 
introduction. They are described in the applet’s online help. 
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Preview 

Overlay 

Configuring the Video Capture Driver 

Compression 

Setting the Capture File - Preallocating and Defragmenting 

Capturing Video 

Playback 

Preview 

The Preview button (third button from the left on the toolbar) toggles preview on 
and off. When preview is enabled, the video you see is updated constantly. What you 
see has the exact format and appearance that uncompressed video captured to file 
will have. If you are using a software compressor to compress the video before 
writing it to file, the compressor’s output will be slightly different.  

Overlay 

The Overlay button (fourth button from the left on the toolbar) toggles Overlay 
mode on and off. When Overlay is enabled, the video you see is updated constantly. 
The difference from Preview is that the Osprey driver will use the fastest and most 
efficient drawing method it can. Normally, with Direct Draw enabled and working, it 
will draw at the full frame rate (30 per second) with minimal processor overhead. 

Note that the Preview and Overlay buttons behave like radio buttons that cancel 
each other - you do not have to shut off preview in order to start overlay.  

Single Frame Capture 

The rightmost button on the toolbar is used to capture a single frame. Every time 
this button is selected, a single frame is captured and displayed in the window. You 
can copy this image and paste it into other applications.  
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Configuring the Video Capture Driver 

You can go through VidCap32 to access the Osprey driver’s Control Dialog (described 
in Chapter 6). The menu selections Options->Video Source... and Options-
>Video Format... access the Control Dialog’s Source and Format pages 
respectively. The selection Options->Video Display... accesses the Closed Caption 
page.  

Compression 

It is possible to compress video as it is captured to disk. Neither VidCap32 nor the 
Osprey video capture driver perform video compression themselves. However, 
VidCap32 may be connected to external software-based compression modules. 
Compression results in a much smaller capture file. The downside is that many types 
of compression are slower: you may have to reduce your frame rate in order to avoid 
dropping an excessive number of frames. With a “quick-compression” methods 
running on a fast machine, however, the extra processing time is slight enough that 
it is fully compensated for by the reduced time needed to write the more compact 
data to disk. 

When a compressor is enabled, video is passed from the Osprey capture driver to the 
compressor, which then writes it to file. The compression dialog, accessed by the 
Options->Compression menu item, allow you to select a compressor, or select no 
compression. The information below for Ligos Technology’s Indeo compressor gives a 
detailed example of how to perform this task. 

Note that the list of available compressors is different for each video Color Format 
selected in the Osprey video capture driver’s control dialog. You should therefore 
select the Color Format you will be using first, then select the compressor. 
Otherwise, you may get an error message when you try to begin video capture.  

Setting the Capture File - Preallocating and Defragmenting 

The leftmost button on the toolbar (or the menu item File -> Set Capture File) 
opens the Capture File dialog box. 

Depending on a number of factors, you may experience a significant percentage of 
frames dropped. The percentage of frames dropped is a function of frame size, use 
of a compressor, and the speed of your system. Performance can be substantially 
improved by preallocating a capture file and defragmenting it. 

“Preallocating” a file means that space has been reserved for it on your hard disk. 
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to want to capture. In AmCap, it is the menu item  
File -> Allocate File Space. You can preallocate multiple files to hold multiple video 
clips. 
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For preallocation to be useful, the hard drive should be defragmented afterwards. 
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

AmCap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and if you 
have Windows 2000 or Windows XP on the system you can use its built-in 
defragmenter. Use AmCap or VidCap32 to preallocate the files, then exit to run the 
defragmentation program. 

 NOTE: Defragment after you allocate and size the capture files. 

After the disk is defragmented, return to AmCap or VidCap32. The files you 
preallocated will now be located on contiguous areas of the hard drive. Their physical 
layout will remain the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 

Defragmenting is a time-consuming procedure, but is worth the trouble if you will 
have an ongoing need to capture high-quality video, particularly uncompressed 
video. Be sure to plan the number and size of files you will need. Once you have the 
defragmented files, be sure not to accidentally delete them - think of them as your 
permanent working space for time-critical operations, not as containers of specific 
video clips. Copy your clips to other files for storage and editing.  

Capturing Video 

The second button from the right opens the Video Capture Dialog. This can also be 
accessed by the Capture -> Video menu item. 

 

The dialog includes controls to set the number of frames per second, as well as an 
optional time limit (in seconds) for the sequence. Buttons are provided to access 
both the video capture driver’s configuration dialog and the compression dialog. You 
can also access and configure audio, assuming that it is installed and enabled. The 
dialog allows a choice between capturing video directly to disk, or capturing via 
memory. Note that capturing to memory may result in fewer dropped frames - but 
not necessarily. 
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For best quality video capture, use a capture rate (frames per second) that is slow 
enough so that there are no dropped frames. 

Once the proper configuration is confirmed, click OK to capture the video. To end 
capture, click the mouse anywhere in the VidCap32 window.  

Playback 

The simplest way to play back a video clip is to find its icon in “My Computer” and 
double-click on it. This will start Windows Media Player, which will automatically play 
the clip. Windows Media Player contains standard start, stop, and pause buttons and 
is largely self-explanatory. Refer to Windows Media Player’s online help for more 
information.  

AmCap 

 

AmCap is a video capture application that is included with the Osprey package. It is 
useful for testing the installation, for general purpose viewing of video, and for 
capturing video to file. AmCap differs from the other general purpose capture 
application, VidCap32, that is included with the Osprey package in that: 

♦ AmCap can handle captured file sizes that exceed the 2 GB limit that 
VidCap32 has. 

♦ AmCap is written using the DirectShow API, and VidCap32 is written using the 
VFW API. Another application that uses DirectShow is Windows Media 
Encoder. 

♦ AmCap does not support software compression modules. 

♦ AmCap's Preview mode is equivalent to VidCap32's Overlay mode. AmCap 
does not have an equivalent to VidCap32's Preview mode. 

AmCap requires the DirectX Media runtime version 6.0 or later in order to run. This 
runtime is included on this CD, and can be installed by the Osprey installation 
program. More information about DirectX Media is available at DirectX Media 
Details. 
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The following instructions take you through the basic scenarios for using this applet. 
AmCap has additional capabilities and settings that are beyond the scope of a brief 
introduction. They are described in the applet’s online help. 

Selecting the AmCap Device 

AmCap Preview 

Configuring the Video Capture Driver in AmCap 

Setting the Capture File - Preallocating and Defragmenting 

Capturing Video 

Playback 

DirectX Media Details 

Selecting the AmCap Device 

 

AmCap requires selecting the input device(s) before you can preview or capture 
video. Use menu item Devices to show a dropdown list of the audio and video 
capture devices present. The video device portion of Osprey-100/200 family cards 
will appear as o100vc.dll - Osprey Capture Card 1 in the list. The audio device on 
the Osprey-200 will appear as Osprey 200 Audio in the same list. If you have 
multiple Osprey cards present, you can select the audio device from this list. Please 
go to The Format Page for instructions on selecting among multiple video sources. 

Multiple board installations are a specialized subject, and are discussed in the section 
entitled Appendix F: MultiBoard Installations.  
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AmCap Preview 

 

When you first start AmCap, there is nothing in the video field display. You must 
enable Preview mode by clicking on the menu item Options -> Preview. When 
preview is enabled, the video you see is updated constantly. What you see is a close 
approximation to the appearance that uncompressed video captured to file will have. 
However, preview video is optimized for fast screen drawing rather than the exact 
capture format, possibly resulting in slight differences in the appearance of the 
video. 

Configuring the Video Capture Driver in AmCap 

You can go through AmCap to access the Osprey driver’s Control Dialog (described in 
Chapter 6). The menu selections Options->Video Source... and Options->Video 
Format... access the Control Dialog’s Source and Format pages respectively. The 
selection Options->Video Display... accesses the Closed Caption page.  

Setting the Capture File - Preallocating and Defragmenting 

The leftmost button on the toolbar (or the menu item File -> Set Capture File) 
opens the Capture File dialog box. 

Depending on a number of factors, you may experience a significant percentage of 
frames dropped. The percentage of frames dropped is a function of frame size, use 
of a compressor, and the speed of your system. Performance can be substantially 
improved by preallocating a capture file and defragmenting it. 

“Preallocating” a file means that space has been reserved for it on your hard disk. 
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to want to capture. In AmCap, it is the menu item  
File -> Allocate File Space. You can preallocate multiple files to hold multiple video 
clips. 
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For preallocation to be useful, the hard drive should be defragmented afterwards. 
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

AmCap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and if you 
have Windows 95/98 on the system you can use its built-in defragmenter. Use 
AmCap or VidCap32 to preallocate the files, then exit to run the defragmentation 
program. 

 NOTE: Defragment after you allocate and size the capture files. 

After the disk is defragmented, return to AmCap or VidCap32. The files you 
preallocated will now be located on contiguous areas of the hard drive. Their physical 
layout will remain the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 

Defragmenting is a time-consuming procedure, but is worth the trouble if you will 
have an ongoing need to capture high-quality video, particularly uncompressed 
video. Be sure to plan the number and size of files you will need. Once you have the 
defragmented files, be sure not to accidentally delete them - think of them as your 
permanent working space for time-critical operations, not as containers of specific 
video clips. Copy your clips to other files for storage and editing.  

Capturing Video with AmCap 
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AmCap requires setting a few options before starting Video Capture. First, set the 
Frame Rate by selecting menu item Capture -> Set Frame Rate... 

 

For best quality video capture, use a capture rate (frames per second) that is slow 
enough so that there are no dropped frames. 

If you are capturing audio, then use menu item Capture -> Capture Audio to turn 
on the checkmark for audio capture. 

 

Set the master stream for audio/video synchronization by using the control dialog 
brought up by Capture -> Master Stream to select whether Audio, Video, or none 
is the master stream for synchronization. 

 

You can optionally set a time limit on this capture through the Capture -> Set Time 
Limit... dialog. 

Once the proper configuration is confirmed, click Capture -> Start Capture menu 
item, then click OK on the confirmation dialog to start your capture. If you did not 
set a time limit, use the menu item Capture -> Stop Capture or press the Esc 
button to end your capture.  
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Playback 

The simplest way to play back a video clip is to find its icon in “My Computer” and 
double-click on it. This will start Windows Media Player, which will automatically play 
the clip. Windows Media Player contains standard start, stop, and pause buttons and 
is largely self-explanatory. Refer to Windows Media Player’s online help for more 
information. 

DirectX Media Details 

Microsoft® DirectX® Media is the media layer of the Microsoft® Windows® 
multimedia system, providing multimedia playback and capture support, image 
transformations, media integration, and animation for the Web and desktop. 

Information Specific to Windows 2000 and Windows XP 

By default, Windows 2000 and Windows XP install different versions of DirectX®.  
The default DirectX® version for each of these operating systems includes the 
appropriate version of DirectX® Media, so, unlike Windows NT, the user does not 
need to separately install Microsoft's DirectX® Media layer. 

The Osprey-100, 101, and 200 have been tested with DirectX® versions 7 and 8.0 
under Windows 2000.  The Osprey-100, 101, and 200 have been tested with 
DirectX® 8.1 under Windows XP. 

Information Specific to Windows NT 

The DirectX® Media runtime is included on this CD, and can be installed by the 
Osprey installation program. See the Readme.txt file for details. DirectX® Media 
requires that Microsoft® DirectX® 3.0 or later be installed. Windows Service Packs 4 
and later contain DirectX® 3.0. More information about DirectX and Windows NT is 
available at http://www.microsoft.com/directx/homeuser/faq.asp - dx4 

http://www.microsoft.com/directx/homeuser/faq.asp#dx4


 Chapter 8 - VidCap32, AmCap, Control Panel, Cropping & Scaling and Indeo 

ViewCast Corporation Osprey Multimedia User's Guide Version 2.2.0 -- 145 

General Information 

More information about DirectX Media is available at: 

http://www.microsoft.com/directx/homeuser/information/dx4nt.asp  

and  

http://www.microsoft.com/directx/homeuser/downloads/default.asp - 
DirectX Media. 

The DirectX Foundation Layer consists of Microsoft DirectDraw®, Microsoft 
Direct3D®, Microsoft DirectInput®, Microsoft DirectSound®, Microsoft DirectPlay®, 
and Microsoft DirectMusic®. Thus, DirectDraw is part of DirectX, and is another 
reason that a video display adapter which supports DirectDraw is desirable.  

More information about DirectX is available at: 

http://www.microsoft.com/directx/homeuser/faq.asp  

and 

 http://www.microsoft.com/directx/homeuser/aboutdx.asp 

The latest version of all DirectX downloads can always be found at:  

http://www.microsoft.com/directx/homeuser/downloads/default.asp 

Because DXMedia is not part of the current DirectX releases, it can be downloaded 
from: 

ftp://www.microsoft.com/developer/platformsdk/july2000/common/redis
t/dxmedia 

The DirectX Media package is distributed with Microsoft’s DirectX 7.0a SDK, which 
can be ordered on CD from Microsoft.  The DirectX Media package has also been 
distributed on the Platform SDK CD in MSDN subscriptions. 

http://www.microsoft.com/directx/homeuser/information/dx4nt.asp
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/faq.asp
http://www.microsoft.com/directx/homeuser/aboutdx.asp
http://www.microsoft.com/directx/homeuser/downloads/default.asp
ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
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Control Panel 

 

The Osprey video capture driver package includes a Control Panel application that 
allows you to control the video source while another application is running. Some 
applications make it hard or impossible to access the driver’s control dialogs while 
they are running. The Control Panel allows you to make these adjustments without 
closing and restarting the primary application. 

Video Input 

Video Format 

Video Adjustments 

Board Select 

Video Input 

The Video Input field controls which of the board’s physical inputs to use. The list of 
available inputs may vary from the illustration depending on the exact hardware you 
have.  

Video Format 

The Video Format field indicates whether NTSC or PAL video is selected and allows 
you to change the format. NTSC is the video standard in North America and Japan. 
PAL is the standard in most European countries, and many other countries as well. 
For simplicity, NTSC and PAL are the only two formats that can be selected from the 
Control Panel. The driver supports additional, less commonly used format with its 
internal dialogs (see Chapter 5), in particular SECAM and PAL-M.  
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Video Adjustments 

The Video Adjustment sliders allow you to interactively control the brightness, 
contrast, saturation, and hue of the video being captured or displayed by the primary 
application. PAL video does not have a hue adjustment.  

Board Select 

The Board Select field is displayed and used only when there are multiple Osprey 
cards installed in the system. The buttons of this field determine which of two, three, 
or four boards is currently being controlled. 

 

NOTE: These buttons affect which board is being controlled, not which board 
the application is connected to. Their action is therefore slightly different 
from the Board Select controls in the driver’s internal Setup Dialogs. 

Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured.  Cropping is done by the 
Osprey card and imposes no extra load on the host computer.  Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 

♦ CropApp, the cropping application 

♦ SDK 

Please see the CropApp Manual which is installed in the Osprey MultiMedia Capture 
Program group for details on using this feature. 
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Ligos Technology Indeo 

Ligos Technology’s Indeo is a software video compressor that works with the Osprey 
Video Capture Driver. It allows you to capture video to disk using much less disk 
space, at the cost of only a slight loss of picture clarity. On a 300 MHz Pentium II 
system you can capture 320x240 NTSC video at a full 30 frames per second with a 
25:1 compression ratio. 

Indeo is included on Osprey Multimedia Capture Driver CDs starting with Osprey 
version 1.50. Refer to Installing Ligos Technology's Indeo in Chapter 3 for 
detailed installation instructions. Ligos Technology has acquired the Indeo® Media 
Software from Ligos Technology Corporation. This codec is rather popular, so you 
may see references to both Ligos Indeo and Ligos Technology Indeo for some 
months. 

You can also download the most up-to-date version for free on Ligos’ web site. As of 
this writing, the location is as follows: 

http://www.ligos.com/indeo/downloads/ 

The file to download currently is iv5setup.exe. You need a version that will 
compress video as well as decompress it. 

Indeo Video compressor version 5.11 works with RGB24 and RGB15. It does not 
work with YUV12 or YVU9. However, the Indeo package does include components 
you can use to capture uncompressed YVU9 and 4:2:2 packed video. 

Use the following steps to demo Indeo with the Osprey card: 

1. Connect and adjust your video source. Start VidCap32. 

2. Use the Options->Format... menu entry to bring up the Osprey driver’s 
Control Dialog Format page. In the drop-down list in the Color Format field, 
select RGB24 (or RGB15). Select ½ sized (CIF) video. Click OK. 

3. Use the Options->Compression... menu entry to bring up the compression 
dialog. In the Compressor: field, select Indeo video 5.11. 

 

http://www.ligos.com/indeo/downloads/
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4. Before leaving the compression dialog, click the Configure... button. Enable 
Quick Compress in the Encoder Controls field, and click OK. 

 
NOTE: If you do not enable Quick Compress, compression will be much 
slower. Click OK again to close the Video Compression dialog box. 

 

5. Select Set Capture File.. under the File menu. Set the name that you want for 
the file that will contain the captured video. Click Open. 

6. Select Capture->Video. Select 30 frames per second for NTSC or 25 for 
PAL/SECAM. Click OK. A confirmation dialog appears. Click OK again to start 
capturing video. 

7. Click anywhere on VidCap32 when you want to end capture 

8. Open My Computer and navigate to the icon of the file that you just captured. 
Click on it and it will play back. 

If you experience more than one or two dropped frames, use a lower frames per 
second capture rate. Useful rates for NTSC video are 30, 15, 10, and 7.5; for 
PAL/SECAM, 25, 12.5, 8.33, and 6.25. 

Indeo has numerous options. You can obtain higher quality video and more 
compression options by capturing uncompressed video and then compressing it off-
line.  
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Chapter 9 - Troubleshooting 

Blue Video Screen 

Black Preview Video Screen 

Scrambled Video Image 

Grainy, Dithered Image 

Slow Overlay Drawing 

Problems using Direct Draw 

Poor Video Quality at Large Frame Sizes 

Wrong Capture Driver Being Accessed 

Unwanted Closed Caption Text 

Interrupt Conflicts 

Cannot Play Back Audio Recorded by the Osprey-200 card 

Multiple Horizontal Lines Across Video Image 

Video Control Dialog Windows are Empty under WinNT 

Blue Video Screen 

The currently selected video input is not receiving an active video signal. 

♦ Check that the camera, VCR, or other video source is powered and that its 
output is connected to the Osprey card’s input. 

♦ Check that the correct video input is selected in the Control Dialog’s Source 
page.  

Black Preview Video Screen 

If you select a Color Format other than one of the RGBs or Grey8, you may get a 
black preview screen. You may also get a message such as VidCap32’s “Error: 
Unable to draw this data format”. The problem is that Video for Windows does not 
know how to decode these more specialized formats. It must be able to locate a 
software video compressor on your system that works with this format. 
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If you encounter this situation with a Color Format that you need or want to use, you 
have to obtain a suitable compressor. For example, if you install Ligos Technology’s 
Indeo compressor (available on Ligos Technology’s web site – see Chapter 7 for 
notes and download instructions) you will be able to preview and capture YVU9 
format.  

Scrambled Video Image 

You may have set the wrong video signal format for the signal input you are using – 
for example, you may have told the driver to look for NTSC-M video but are using a 
PAL-BDGHI video source. First, make sure you know what signal format your video 
source is generating. Then, go into the Video Standard field of the Control Dialog’s 
Source page, and click the button for that signal format.  

Grainy, Dithered Image 

Check that you are using a display format with greater than 256 colors. If a 256 
color format is used, the system can only approximate the actual colors, and does so 
with a loss of resolution and precision. You can determine (and if necessary adjust) 
the display depth from the field titled Color Palette under the Settings tab of the 
Control Panel ... Display.  

Slow Overlay Drawing 

You should be able to obtain 30 frame per second with minimal processor loading by 
enabling Direct Draw. System requirements for realizing this speed are: 

♦ a video display card that supports Direct Draw, 

♦ a video display device driver for the card that supports Direct Draw, 

Either or both of the two checkboxes in the Direct Draw field of the Control Dialog’s 
Configuration page must be checked. 

Refer also to Appendix E, Direct Draw.  
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Problems using Direct Draw 

Direct Draw is a recent technology and it is possible that you may have problems 
using it with your particular combination of display adapter, display driver, and 
machine. Any problems should arise only when Overlay mode screen drawing is in 
use; the Osprey card does not use Direct Draw at other times. If you do have 
problems, disable either or both Direct Draw methods by unchecking their boxes in 
the “Direct Draw” field of the Control Dialog’s Configuration page. We have seen 
problems with Secondary Direct Draw on a few older display adapters.  

Refer also to Appendix E, Direct Draw, for more details.  

Poor Video Quality at Large Frame Sizes 

Large frame sizes with the deep pixel depth (24- or 32-bit), or complex format 
(YVU9 or YUV12 planar), impose heavy demands on the PCI bus’s data transfer 
capacity. Our experience is that some systems cannot handle these formats at full 
frame sizes. 

Systems vary in their data transfer limits. The characteristics of the PCI bridge are 
often more important than processor speed. 

If you are having problems, we recommend that you: 

♦ Use a smaller frame size (480x320 or less). 

♦ Use a shallower color format (RGB15 or RGB24 instead of RGB32). 

♦ Try an RGB format instead of a YVU format, and a packed format instead of a 
planar format. 

♦ If you have a choice of PCs for video capture, try using another system with a 
different system board chipset.  

Wrong Capture Driver Being Accessed 

This might happen if you already had another capture board/capture driver on your 
system when you installed the Osprey card. The Osprey installation procedure allows 
you to set the Osprey driver as either the primary or secondary video capture driver. 
The section Appendix D: Using the Osprey Video Capture Driver with Other 
Video Capture Drivers gives a full description of how to set the Osprey driver as 
the primary driver. 

Some applications, including VidCap32, allow you to select which video capture 
driver to use. In VidCap32, a list of installed video capture drivers is appended to the 
bottom of the Options... menu.  
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Unwanted Closed Caption Text 

Closed Caption text consists of white or colored characters drawn on black character 
cells. 

In video that contains Closed Captioning information, the first active line of video in 
each field contains encoded Closed Caption text. In video that does not have Closed 
Captioning information, that line is simply ordinary video. 

If you leave Closed Captioning enabled and view non-Closed Caption video, the 
Osprey video capture driver will attempt to interpret the first line of each field of 
video as Closed Caption character codes. Some video may appear sufficiently similar 
to Closed Caption data that the software thinks it is Closed Caption text. The result 
will be occasional randomly drawn text appearing on the screen. 

The solution is to turn off Closed Captioning when you are viewing sources that are 
not Closed Captioned. To do so, open the Control Dialog’s Closed Caption page and 
uncheck the Enable box in the Display field. The change takes effect when video is 
restarted after exiting the dialog. 

For more information about Closed Captioning, refer to The Closed Caption Page in 
Chapter 6.  

 
PAL video sources do not contain closed captions. 

Interrupt Conflicts 

Failed network connections, failure of a device drive to initialize during start-up, or 
failure of the Osprey card and driver to operate properly are often be traced to 
interrupt (IRQ) conflicts. In our experience, IRQ conflicts are most commonly seen 
when a PCI SCSI adapter, or possibly a PCI network adapter, is present in the 
system. 

Conflicts Between PCI Cards 

Conflicts of PCI Cards with ISA Cards 

Conflicts Between PCI Cards 

PCI cards and drivers do not choose which IRQs they use; rather, the operating 
system assigns IRQ lines to PCI cards. The Osprey driver finds out the IRQ 
configuration for its card or cards from Windows NT, and it cannot change this 
configuration. You can, however, cause the operating system to assign IRQs 
differently, by rearranging cards or changing BIOS settings. 
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Multiple PCI cards are supposed to be able to share the same IRQ line. In practice, 
occasionally you may encounter a device driver that is not implemented correctly for 
interrupt sharing. If this problem arises, you have to rearrange the PCI cards so that 
the non-compliant card does not share its IRQ line with any other device. 

Another problem is that some PCI device drivers expect to use a particular IRQ line. 
When a new card is added, it causes the system to assign IRQs differently. If the IRQ 
assignment for a particular card is changed and its device driver does not detect the 
change, this will cause the system to work incorrectly. 

The simple answer to this problem is it can sometimes be solved by physically 
rearranging the PCI cards such that their arrangement in the PCI slots is different. 
When doing this keep careful notes of the arrangements you have tried. 

Another approach to PCI card conflicts is at the BIOS level. Depending on what kind 
of system BIOS you have, you may be able to change which IRQ lines are allocated 
to PCI devices versus ISA devices. You may be able to allocate more IRQ lines for 
PCI devices and thereby solve a PCI conflict. 

If these approaches do not work, it is probably time for you to email us or call our 
technical support line. We have a diagnostic tool that may be helpful.  

Conflicts of PCI Cards with ISA Cards 

A PCI card and an older-style ISA card can never share IRQ lines. Windows NT 
cannot detect with certainty what IRQ line an ISA card is using, and hence cannot 
always prevent the conflict. 

You can view the system’s IRQ assignments by running the Windows NT Diagnostics 
program in the Administrative Tools menu or program group. Select the Resources 
tab and click the IRQ button at the bottom of the field. If the list of cards shows an 
ISA card using the same IRQ as another device, the conflict should be resolved by 
changing the IRQ of the ISA card. 

Unfortunately, if a device driver for an ISA card has failed to initialize because of an 
IRQ conflict, the card’s IRQ will not appear in the list. To find the conflict, you have 
to examine all your ISA cards with the Control Panel to find out what IRQs they are 
trying to use.  

Cannot Play Back Audio Recorded by the 
Osprey-200 Card 

If you have a sound card installed, you should be able to hear audio when you play 
back recorded audio. 
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♦ Verify that the volume control for your playback device is not muted. 

♦ Verify that the selected playback device is your sound card, and not the 
Osprey-200 Placeholder device. The Placeholder device exists in order to 
handle the situation where there is an Osprey-200 present without a sound 
card. Some Windows applications cannot use a recording device unless a 
playback device is also installed. The Placeholder device cannot play back 
recorded audio. You can use the same method to select playback device that 
you use when selecting the audio source.  

Multiple Horizontal Lines Across Video 
Image 

If there are multiple, regularly spaced, horizontal lines across your video image and 
your source material is copyrighted and copy-protected, you are seeing 
Macrovision™ copy protection. It looks like this: 

 

The lines can vary in color from yellow to blue to green. These lines are not present 
in every frame of video. There may also be a black band at the top of the frame. 

The Osprey Video Capture card cannot eliminate these video artifacts. These artifacts 
will only be present when you are using a copy-protected source, such as a high-
quality DVD for testing a card.  
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Video Control Dialog Windows are Empty 
under WinNT 

This problem occurs only for Windows NT installations that are running Service Packs 
earlier than SP4, or that are running versions of Internet Explorer earlier than 
version 4. The problem is caused by the Osprey driver software's use of features 
(window dialog controls) provided by Windows NT that were introduced in 1999.  

This problem can be fixed by: 

♦ applying NT Service Pack 4 or later.   

 

Service Pack 6a  is required to use Microsoft's Windows Media Encoder 7.1 
and Media Player 7.1. 

♦ installing Internet Explorer version 4 or later downloading and installing the 
latest version of 401Comupd.exe from Microsoft's website at 
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.a
sp 

http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
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Appendix A - Hardware Specifications 

The physical specifications for the Osprey Multimedia capture cards are as follows. 

Table A-1   Physical Dimensions 

Length 133 mm 

Width 22 mm 

Height 121 mm 

Weight 63 grams 

Table A-2   Environmental Specifications 

Operating temperature range 0º to 40º C 

Non-operating temperature range -40º to +75º C (RH) 

Operating humidity range Between 5% and 80% (non-condensing) 
@ 40º C 

Non-operating humidity range 95% RH (non-condensing); gradient 
30% per hour 

Operating altitude range 0 to 3,048 meters (10,000 feet) 

Non-operating altitude range 0 to 15,240 meters (50,000 feet) 
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Appendix B - Color Modes 

The Color Format field of the Control Dialog’s Format page allows you to select the 
following video formats. 

Format Description 

RGB32 Each pixel has four bytes (32 bits) of data - one each for red, 
green, and blue, plus one byte of padding. The pixel has 256 
shades of each of the three colors, for a total of 16.7 million 
colors. This is a “true color” mode. 

RGB24 Each pixel has three bytes (24 bits) of data - one each for red, 
green, and blue. This is another “true color” mode with 16.7 
million colors, and is a recommended format for capturing 
images with the highest possible color accuracy. 

RGB15 Each pixel has two bytes (16 bits) of data. There are 5 bits 
each of red, green, and blue data; the sixteenth bit is unused. 
This is a “high color” mode, also known as “5:5:5.” 

Grey8 Each pixel has one byte of data, representing one of 256 
grayscale levels. 

4:2:2 packed Also known as YUY2. This modes represent each pixel with a 
total of 2 bytes (16 bits) of data. The data is encoded as 
separate data for luminance (intensity) and chrominance 
(color). This mode is mainly used as an input to software 
compressors. See below. 

YUV12 planar Also known as I420. This is a complex format in which there 
are in the aggregate 12 bits of data per pixel. Each pixel has 8 
bits of luminance data. Each group of 4 adjacent pixels shares 
two bytes of chrominance data. See below. 

YVU9 planar Similar to YUV12 planar, except that there are in the aggregate 
9 bits of data per pixel, and each byte pair of chrominance data 
is shared by 16 adjacent pixels. See below. 

YUV Format Details 

4:2:2, YVU9, and YUV12 are YUV formats. In these formats, each pixel is defined by 
an intensity or luminance component, Y, and two color, or chrominance, 
components, U and V. Since the human eye is less sensitive to color information than 
to intensity information, many video formats save storage space by having one 
luminance byte per pixel but sharing the chrominance byte among two or more 
pixels. YUV is also very similar to the color encoding used for analog color television 
broadcast signals. 

4:2:2 packed mode consists of a single array of mixed Y, U, and V data. Each pixel 
has one Y (intensity) byte. Each pixels shares its U and V bytes with one of the pixels 
horizontally next to it: 
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pixels 1 and 2: byte 1 = y1 byte 1 intensity 

 byte 2 = u1/2 shared U color information for bytes 1 and 2 

 byte 3 = y2 byte 2 intensity 

 byte 4 = v1/2 shared V color information for bytes 1 and 2 

   

pixels 3 and 4: byte 5 = y3  

 byte 6 = u3/4  

 byte 7 = y4  

 byte 8 = v3/4  

4:2:2 packed mode uses the same number of aggregate bytes per pixel as RGB15 – 
namely, two. However, 4:2:2 is more efficient than RGB15 because it stores 
relatively more of the intensity information that the human eye is most sensitive to. 

YVU9 and YVU12 are "planar" modes - the Y, U, and V components are in three 
separate arrays. It is easiest to explain the format with an example: Let's say you 
have a 320x240 YVU9 format. The buffer will have 320x240 bytes of Y data, followed 
by 80x60 bytes of V data, followed by 80x60 bytes of U data. So each U and each V 
byte together contain the color information for a 4x4 block of pixels. 

Similarly, a 320x240 YUV12 format has a 320x240 Y array followed by a 160x120 U 
array and then a 160x120 V arrays. Note that the in the I420 format used by Osprey 
the order of the U and V arrays is reversed from the order in the YVU9 format.  

 

In the I420 format used by Osprey, the order of the U and V arrays is 
reversed from the order in the YVU9 format. 
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Appendix C - Video Sizes 

The table below gives the standard video sizes available through the Control Dialog’s 
Format page. 

The 525-line video formats are NTSC-M, NTSC-J, and PAL-M. 

The 625-line video formats are PAL-BDGHI, PAL-N, PAL-NC, and SECAM. 

CCIR601 is a video proportioning standard that can be selected on the Control 
Dialog’s Format page. 

Available Video Sizes 
(Width x Height:) 

 525-line 
(Sqr Pixels) 

525-line 
(CCIR601) 

625-line 
(Sqr Pixels) 

625-line 
(CCIR601) 

Full 640x480 720x480 768x576 720x576 

1/2 (CIF) 320x240 360x240 384x288 360x288 

3/8 240x180 270x180 288x216 270x216 

1/4 (QCIF) 160x120 180x120 192x144 180x144 
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Appendix D - Using the Osprey Video 
Capture Driver with Other Drivers 

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 and Windows XP. 

If you already have a video capture driver installed in your system, the Osprey 
installation software gives you the option of installing the Osprey driver as your 
primary video capture driver. A dialog box giving you a choice comes up near the 
end of the installation sequence. 

If you install it as your primary video capture driver, it will automatically connect to 
Video for Windows applications as the default driver. If you install it as a secondary 
or auxiliary video capture driver, it will not be accessible to Video for Windows 
programs and utilities that lack a control for selecting a specific capture driver; your 
other driver, however, will remain immediately accessible as the default driver. 

What if you have a need to change drivers and capture cards, once or repeatedly? 
The most safe-and-certain way is to run the old driver’s uninstall program and then 
run the new driver’s install or setup program. You may find it easier, however, to use 
the system Control Panel to remove and install drivers. 

The Control Panel’s “Remove” does not actually remove a driver permanently from 
your system. Its files are still in the same locations on your hard disk. Rather, it 
alters the registry settings so that the driver does not appear on the list of active 
drivers. When you later “Add...” a driver that is removed in this way, you have the 
choice of using the existing files, or copying in new ones. 

Use the Control Panel’s Multimedia Add... function to activate the primary driver you 
want. The Add... function replaces the previous primary driver with the new one. 
This is usually in fact what you want to do. There is no way to designate a driver as 
secondary or auxiliary using the Control Panel. 

Because the NT 4.0 Add... function acts more like a “Replace...” function if a driver 
is already there, the Remove function is not really needed. This is fortunate, 
because it does not work for all video capture drivers. It appears to, but the registry 
does not actually get updated. (For the Osprey driver, the Remove function does 
work.) If both a primary and a secondary driver are installed, and you Remove the 
primary driver, and the function works correctly, the secondary driver becomes the 
primary driver. 

To "Add..." a driver, proceed as follows: 

To "Remove" a driver, proceed as follows: 
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To "Add..." a driver, proceed as follows:  

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 and Windows XP. 

1. Open My Computer and double click on the Control Panel icon. The Control 
Panel window will come up. 

2. Double click on the Multimedia icon. The Multimedia Properties window will 
come up. 

3. Click on the Devices tab. A list of multimedia devices will appear. 

4. Click on the Video Capture Devices selection; it should become highlighted. 

5. Click the Add... button at the bottom of the window. A window titled Add 
appears, with a list of drivers. 

6. If the driver you want to add is in the list, highlight it and click OK. Follow 
whatever further directions come up that are specific to the driver. 

7. If the driver you want is not on the list, highlight the first item, Unlisted or 
Updated Driver, and click OK. 

8. You now get a dialog that prompts for a pathname. You have to provide the 
location of an “INF” file for the driver. This is a file belonging to the driver of 
interest entitled “o100drv.inf”. You can either type in the path or click the 
Browse... button to select the path. For the Osprey software, this file will be in 
the directory where the software was installed, by default \Program 
Files\Osprey Multimedia Capture on the default drive. When you have the 
correct path in the dialog, click OK. 

9. A dialog entitled Add Unlisted or Updated Driver will now come up. There could 
be several choices of drivers; if so, select the one for a video capture driver and 
click OK. 

10. Follow any further directions specific to the particular driver that come up.  
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To "Remove" a driver, proceed as follows:  

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 and Windows XP. 

1. Open My Computer and double click on Control Panel. The Control Panel 
window will come up. 

2. Double click on the Multimedia icon. The Multimedia Properties window will 
come up. 

3. Click on the Devices tab. A list of multimedia devices will appear. 

4. Click on the plus sign to the left of small icon marked Video Capture Devices. 

5. Click on (and highlight) the video capture device you want to remove. 

6. Click on the Remove button at the bottom of the window. 

7. A confirmation dialog will come up. Click Yes to deactivate the driver. 

8. Verify that the driver was actually removed by closing the Multimedia window, 
restarting it, and seeing if the driver is in fact gone from the Video Capture 
Device list.  
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Appendix E - Direct Draw 

Direct Draw is a fast on-screen drawing method. 

The Osprey video capture driver utilizes Direct Draw for drawing video overlays. 
Video overlay is a display mode available in most video capture applications, 
including VidCap32. It is enabled by clicking an Overlay button, or by selecting an 
Overlay menu entry. It is distinct from Preview mode. Preview mode does not 
utilize Direct Draw. 

Direct Draw is enabled by the Direct Draw Enable checkbox on the Control Dialog’s 
Configuration page. When Direct Draw is enabled, the Osprey driver will attempt to 
use it for overlays. If it cannot (e.g. the display driver does not support Direct Draw) 
then it will fall back to the default drawing method, DibDraw. 

When Direct Draw is used, video is copied by direct memory access (DMA) directly 
from the Osprey board to the visible screen memory, and video is overlaid at 30 
frames per second with very low main processor utilization. When Direct Draw is not 
used, video is copied by DMA into system memory, and then copied again into 
display memory. Frame rate without Direct Draw is 30 per second for smaller frame 
sizes, but less for larger sizes; and processor loading is substantial. 

In order to utilize Direct Draw, the following conditions must be met: 

♦ You have to enable Direct Draw by checking the Enable button on the Control 
Dialog’s Configuration page. 

♦ Your video display card must support Direct Draw. 

♦ The software device driver for your video display card must support Direct 
Draw. It is recommended that you use the most recent driver available. The 
drivers on the Windows NT 4.0 CD-ROM do not in all cases support Direct 
Draw. You can obtain the most recent version from your video card 
manufacturer’s FTP site. 

♦ You must be using a video format other than Grey8. The Osprey driver does 
not support Direct Draw of grayscale video. 

You can tell whether the system is using Direct Draw as follows: When Direct Draw is 
in use, the display near the video capture window will flicker when either the video 
capture window or an overlapping menu or window is moved. When DibDraw is being 
used, there will be no flicker. 

You can also measure CPU utilization using the Task Manager’s performance meter. 
When measuring CPU utilization, first shut down any applications that might be 
actively consuming significant CPU time. CPU utilization will be just a few percent 
when Direct Draw is running. If DibDraw is running, CPU utilization will be 
substantial, especially if the image is large.  
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Appendix F - Multiboard Installations 

The multiboard capability of the Osprey Video Capture Driver allows both single and 
multiple applications to simultaneously access multiple boards. However, the driver 
does not allow multiple applications or processes to access a single board unless the 
added-cost SimulStreaming option has been enabled for the board, or another 
special circumstance exists. 

First, some background on the logic by which the Osprey driver determines 
connection or startup order for multiple boards: 

The numbering of the boards is determined by the order in which the operating 
system recognizes their presence in the slots in which they are installed. The 
arrangement of logical PCI slots is different for different machines, and you will have 
to experiment to determine which physical board is Board 1. Also, the numbering 
under Windows 2000 and Windows XP may differ from the numbering under 
Windows NT 4.0. 

Every time the system is rebooted, the Osprey Video Capture drivers enumerate the 
boards in the system and make unique video capture entries for each board. If the 
Multiple Opens box is not checked to allow multiple opens of each board on The 
Configuration Page of the Osprey Video Capture Driver's Control Dialog, a default 
entry is made that represents the legacy method of opening multiple devices, as well 
as registry entries for individual boards. If the box is not checked (the recommended 
method), only entries for specific cards are created. 

The Recommended Multiboard Selection 
Approach 

The recommended method is to check the Multiple Opens box on The 
Configuration Page of the Osprey Video Capture Control Dialog. Not checking this 
box results in the generation of only individual names as video capture device 
entries. For example, the following msvideo entries appear for two Osprey Video 
Capture devices in the system: 

o100vc.dll - Osprey Capture Card 1 
o100vc.dll - Osprey Capture Card 2 

These "Card 1/Card 2" names should be used when opening an Osprey-100 or 200. 
In the event that you see a "Card Default" entry (see The Legacy Multiboard 
Selection Approach below), this entry is for legacy applications that did not allow for 
specific device selection. When using the device specific (numbering) approach to 
open the device and bring up the video driver's Control Dialog, the correct board is 
automatically selected in the Board Select field box. 
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The Legacy Multiboard Selection Approach 

The non-recommended method is not to check the Multiple Opens box on the 
Configuration Page of the Osprey Video Capture Control Dialog. Checking this box 
results in the generation of individual device names, as well as a Card Default name, 
as video capture device entries. For example, the following msvideo entries appear 
for two Osprey-200 devices in the system: 

o100vc.dll - Osprey-100 Card Default 
o100vc.dll - Osprey Capture Card 1 
o100vc.dll - Osprey Capture Card 2 

If two or more boards are installed and you use the default device name to access 
the Osprey driver, it first connects to the default board. Normally, the default board 
is whichever board was most recently selected in the Board Select field of the Control 
Dialog. If this default board is in use (and the MultiOpen option is turned off), the 
next available board is automatically selected. Once any board is selected, you can 
change it to a different board by opening any page of the video driver's Control 
Dialogs with a board select field, selecting the board that you want, and clicking OK. 

If you have a mixture of Osprey-200 and Osprey-100 boards installed, then 
situations can exist where a particular board is addressed as "Board 2" for the video 
driver, and "Osprey-200 Audio board 1" for the audio driver. When mixing 
audio/video and video-only boards, it is prudent to verify how the boards are 
numbered by your operating system before you begin capture. 

Multiple boards may be accessed according to three main scenarios: 

♦ Multiple processes accessing multiple boards: Start two standard applications 
- or two copies of one application - such as VidCap32. The first copy will come 
up connected to the default board and will start normally. The second copy 
will automatically hunt for the next available board in ascending numerical 
order. 

♦ A single application accessing multiple Boards: A single custom application 
can access two or more different boards. If the standard Video for Windows 
interface is used, the access order is the same as described above. 

♦ Multiple applications accessing single board:  If you have the added-cost 
SimulStream upgrade, then multiple applications can access a single board.  
This option is described in detail in the SimulStreaming User's Guide. 

Multiple Opens is much more precise and flexible for custom applications that use the 
Osprey-100 Software Developers’ Kit (SDK). This kit allows you to override the 
default board order to access any board at any time.  

It is recommended that developers of multiple board applications obtain our Video 
for Windows developers’ kit, described in Appendix H. Please inquire at 
mailto:support@viewcast.com for more information. 

Note for Osprey-50 users: Whereas the Osprey-100, -101, and -200 have full 
support for multiple boards in the system, the Osprey-50 is primarily a single-board-
per-computer product. It is possible, however, to use one Osprey-50 in the same 
system with one or more of the other Osprey cards.  

mailto:support@viewcast.com
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Appendix G - Files and Registry Usage 

The following are the files that are written and registry entries that are set when the 
Osprey drivers are installed. This information will allow a technically proficient user 
to remove the Osprey installation if the uninstaller is deleted or damaged. 

Instructions for Windows NT 4.0 

Instructions for Windows 2000 and Windows XP 

 

These instructions are for advanced users only! Refer to Chapter 3 - 
Installing the Software - Windows 2000 or Chapter 4 – Installing 
the Software – Windows XP or Chapter 5 - Installing the Software 
- Windows NT 4.0 to remove the software. Be careful not to delete or 
alter any items other than the ones described here! 

Instructions for Windows NT 4.0:  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to “Remove” the driver 
(and delete these entries) before deleting individual files and registry entries. 

2. In the main Windows NT ..\System32 directory, these files can be removed: 

o100vc.dll 
o2ca_mix.dll 
o2ca_usr.dll 
o2ca_wav.dll 
o200board.dll 
SimulKey2.dll 
otiyuv.dll 

3. In the main Windows NT..\System32\drivers directory, these files can be 
removed: 

o100drv.sys 
o2ca.sys 

4. The Osprey Capture Driver directory, its subdirectories, and its files can be 
removed. Typically this directory is \Program Files\Osprey Multimedia Capture 
on the default drive. The installation procedure puts the following files in that 
directory: 

amcap.exe 
CropApp.exe 
xctlapp.exe 
osprey.ico 
Osprey-200 Special Offers.url 
SimulStreaming_Users_Guide.pdf 
VidCap32.exe 
VidCap.hlp 
license.txt 
Driver directory 
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5. The installation program also creates a directory called NT within the Osprey 
MultiMedia Capture install directory which contains the following files: 

CroppingManual.pdf 
files DelsL*.isu 
Osprey Bird only_dark gray 1.bmp 
Osprey Bird only_light gray.bmp 
Osprey Bird_dark gray.bmp 
Osprey Bird_light gray.cmp 
Osprey Video_darkgray.bmp 
Osprey Video_lightgray.bmp 
Osprey100-200_Manual.pdf 
Osprey210-220_Manual.pdf 
ReadMe.txt 
VCST1.bmp 
VCST2.bmp 
VCLogo.bmp 
SimulStreamEval.bmp 
the Help subdirectory and all its contents 

6. In the registry, the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral or may not be present. The descriptive text 
"Osprey Capture Card 1" may be different; there can be "Osprey Default 
Card" present, and the numerals on the capture cards may be different. 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Drivers32 entries: 

"wave1"="o2ca_wav.dll" 
"mixer1"="o2ca_mix.dll" 
"msvideo1"="o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.i420 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.yuy2 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey100 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey200 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\drivers.desc entries: 

"o100vc.dll"="Osprey Video Capture Driver" 
"o2ca_wav.dll"="Osprey Audio Wave Driver" 
"o2ca_mix.dll"="Osprey Audio Mixer Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey100 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey200 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation / Osprey Video 
Division\Osprey MultiMedia Capture 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey MultiMedia Capture 
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♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o100drv 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ca 

♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey100 

7. You can delete the Taskbar entry by selecting Taskbar Properties-> Start Menu 
Programs -> Remove. 

Instructions for Windows 2000 and Windows XP:  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to " 

2. In the main Windows 2000 (XP) ..\System32 directory, these files can be 
removed: 

o100vc.dll 
o2ca_mix.dll 
o2ca_usr.dll 
o2ca_wav.dll 
o200board.dll 
OtiPnp.dll 
SimulKey2.dll 
otiyuv.dll 

3. In the main Windows 2000 (XP) ..\System32\drivers directory, these files can 
be removed: 

o100drv.sys 
o2ca.sys 

4. The Osprey MultiMedia Capture install driver directory, its subdirectories, and 
its files can be removed. Typically, this directory is \Program Files\Osprey 
MultiMedia Capture on the default drive. The installation procedure puts the 
following files in that directory: 

amcap.exe 
CropApp.exe 
xctlapp.exe 
o100drv.inf 
osprey.ico 
Osprey-200 Special Offers.url 
SimulStreaming_Users_Guide.pdf 
Vidcap.hlp 
Vidcap32.exe 
license.txt 
Driver directory 
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5. The installation program also creates a directory called NT within the Osprey 
MultiMedia Capture install directory which contains the following files: 

CroppingManual.pdf 
files DeIs*.isu 
Osprey Bird only_dark gray1.bmp 
Osprey Bird only_light gray.bmp 
Osprey Bird dark_gray.bmp 
Osprey Bird_light gray.bmp 
Osprey Video_darkgray.bmp 
Osprey Video_lightgray.bmp 
Osprey100-200_Manual.pdf 
Osprey 210-220_Manual.pdf 
ReadMe.txt 
VCST1.bmp 
VCST2.bmp 
VCLogo.bmp 
SimulStreamEval.bmp 
the Help subdirectory and all its contents 

6. In the registry the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral or may not be present. The descriptive text 
"Osprey Capture Card 1" may be different; there can be "Osprey Default 
Card" present, and the numerals on the capture cards may be different. 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Drivers32 entries: 

"wave1"="o2ca_wav.dll" 
"mixer1"="o2ca_mix.dll" 
"msvideo1"="o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.i420 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.yuy2 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey100 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\drivers.desc entries: 
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"o100vc.dll"="Osprey Video Capture Driver" 
"o2ca_usr.dll"="Osprey Audio Driver" 
"o2ca_wav.dll"="Osprey Audio Wave Driver" 
"o2ca_mix.dll"="Osprey Audio Mixer Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey100 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey200 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation/ Osprey Video 
Division\Osprey MultiMedia Capture 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey MultiMedia Capture 

♦ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\MediaResources\msv
ideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\MediaResources\msv
ideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\MediaResources\
msvideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ca 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o100drv 

♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey100 

7. You can delete the Taskbar entry by selecting Taskbar Properties -> Start 
Menu Programs -> Remove.  
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Appendix H - Developer Support 

The Osprey Technologies group has a software developers’ kit (SDK) to assist 
development of specialized Video for Windows applications. The kit provides 
capabilities that the Video for Windows API does not provide. It uses a proprietary 
interface that bypasses Video for Windows and connects your application directly to 
the Osprey video capture driver. 

The developers’ kit at present has the following modules: 

♦ Methods by which a single application can access multiple boards - see also 
Appendix F. 

♦ Interactive control of video source, brightness, contrast, hue, and saturation 
from inside an application 

♦ A Closed Captioning API, by which the application can control Closed 
Captioning and capture Closed Caption text for specialized processing and 
display. 

♦ An API for Controlling on-video logos - see Chapter 5, The Logo Page. 

♦ An API for capture of raw Vertical Blanking Interval (VBI) data. 

♦ Direct access to the Bt878 registers. 

♦ An API for Controlling cropping parameters - see the CropApp Manual. 

♦ An example Audio Mixer program. 

♦ Please inquire at mailto:support@ospreyvideo.com for further information.  

mailto:info@osprey.viewcast.com
mailto:support@ospreyvideo.com
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Appendix I - The Audio Cfg Applet 

The Audio Settings applet has been removed from the release.  Please see Registry 
Settings Controlled by the Audio Cfg Applet for information on how to change 
the Rate Conversion Selection and Gain Selection. 

Registry Settings Controlled by the Audio 
Cfg Applet  

The Audio Settings applet places registry values in these twigs of the registry: 

♦ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey200\DeviceX\Audio\RateCo
nversion 

RateConversion may be set to 1, 2, or 3 only. 

When RateConversion is: 

1 - use filter converter (default) 

2 - use skip converter (skips samples) 

3 - use Microsoft PCM method 

♦ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey200\DeviceX\Audio\Gain 

The default value of Gain is 2. Set it higher for increased software audio gain. 
Set it below 2 to decrease gain. 
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Appendix J - Adding/Moving Boards in 
Windows 2000 and Windows XP  

Under Windows 2000 and Windows XP, when the Osprey MultiMedia Capture driver 
has been installed and another Osprey board is put into a slot that has not previously 
contained a board, the following sequence is initiated. This can happen because an 
Osprey board has been moved to a different PCI slot or when a board is being added 
to the machine. It occurs because of the manner in which Windows 2000 or Windows 
XP enumerates devices. 

The New Hardware Wizard runs and displays the Found New Hardware window 
followed by the Digital Signature Not Found window. 

 

 

1. Click Yes. 

The Multimedia Controller installing window (not shown) displays, and the text 
inside this window changes to "Osprey Video Capture Device, Installing ..." . 
Then the Digital Signature Not Found window appears on top of it. 
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2. Click Yes. 

The Completing the Found New Hardware window displays. 

3. Click Finish. 

The Digital Signature Not Found window displays. 

4. This window displays once for each Osprey board you are installing. 

The Systems Setting Change window displays. 

5. Click Yes to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

 


	Chapter 1 - Getting to Know the Osprey Multimedia Capture Cards
	Symbols
	Introduction
	Features
	Video Frame Rates

	Software Included
	Compatible Third Party Applications
	Inter/Intranet video servers
	Video conferencing
	Video editing

	Getting Help

	Chapter 2 - Osprey Capture Card Hardware
	System Requirements
	Configuring the Card
	Installing the Card
	Connecting Cables
	Connecting a Composite Source
	Connecting an S-Video Source
	The Osprey-101 Video Camera
	Connecting an Audio Source to the Osprey-200
	Connecting Audio with the Osprey-50, Osprey-100, and Osprey-101


	Chapter 3 - Installing the Software - Windows 2000
	Basics: Installing From CD
	Basics: Downloading and Installing Updated Drivers
	Canceling Out of the Found New Hardware Wizard
	Three Install Scenarios
	Scenario 1:  Osprey Card(s) not Physically Installed in the PC
	Scenario 2:  Osprey Card(s) Physically Installed, but Osprey Software not Installed
	Option A: Run the Installation Program (Recommended)
	Option B: Use the New Hardware Found Wizard (Not Recommended)

	Scenario 3:  Osprey Card(s) Physically Installed, and Previous Osprey Software Installed
	Option A: Run the Installation Program (Recommended)
	Option B: Use the Device Manager (Normally not Recommended)


	Installing Ligos Technology's Indeo
	Testing the Installation
	Uninstalling the Software

	Chapter 4 – Installing the Software – Windows XP
	Basics: Installing From CD
	Basics:  Downloading and Installing Updated Drivers
	Two Installation Scenarios
	Scenario 1:  Osprey Card(s) not Physically Installed in the PC
	Scenario 2:  Osprey Card(s) Physically Installed, but Osprey Software not Installed
	Option A: Run the Installation Program (Recommended)
	Option B: Use the New Hardware Found Wizard (Not Recommended)


	Testing the Installation
	Uninstalling the Software

	Chapter 5 - Installing the Software - Windows NT 4.0
	Installing from CD
	Downloading and Installing Updated Drivers
	Setup Program: Details
	Setup Program: Details

	Installing Ligos Technology's Indeo
	Testing the Installation
	Uninstalling the Software

	Chapter 6 – Video Control Dialog
	Accessing the Dialog
	Instructions for Windows NT 4.0
	Instructions for Windows XP
	Instructions for Windows 2000

	General Features of the Dialog
	Source, Format, Closed Caption, Logo, Advanced Features, Configuration, SimulStream
	OK
	Cancel
	Restore Defaults
	Restore Previous
	Help

	The Source Page
	Input
	Video Standard
	Video Settings

	The Format Page
	Color Format
	Video Size
	Custom Size
	Proportions (Pixel Aspect Ratio)
	Cropping and Scaling

	The Closed Caption Page
	Display on Screen
	Save to File
	Mode
	Channel
	Text Color
	Apply Changes to all Boards

	The Logo Page
	Capabilities
	Step 0 - Before You Start
	Step 1 - Creating and Enabling the Logo
	Step 2 - Selecting the Logo File
	Step 3 - Setting Key Color and Style
	Step 4 - Positioning the Logo
	Step 5 - Reviewing and Saving the Changes
	Notes on Logos

	Advanced Features
	Field Order
	The De-Interlacing Motion Filter

	The Configuration Page
	Overlays
	Access to Format Tab
	Multiple Opens
	Default Capture Device

	The SimulStream Page
	Cropping and Scaling

	Chapter 7 - Capturing Audio
	Selecting the Audio Source
	Setting Input Volume
	Setting Sound Format
	Audio Playback

	Chapter 8 - VidCap32, AmCap, Control Panel, Cropping & Scaling and Indeo
	VidCap32
	Preview
	Overlay
	Single Frame Capture
	Configuring the Video Capture Driver
	Compression
	Setting the Capture File - Preallocating and Defragmenting
	Capturing Video
	Playback

	AmCap
	Selecting the AmCap Device
	AmCap Preview
	Configuring the Video Capture Driver in AmCap
	Setting the Capture File - Preallocating and Defragmenting
	Capturing Video with AmCap
	Playback

	DirectX Media Details
	Information Specific to Windows 2000 and Windows XP
	Information Specific to Windows NT
	General Information

	Control Panel
	Video Input
	Video Format
	Video Adjustments
	Board Select

	Cropping and Scaling
	Ligos Technology Indeo

	Chapter 9 - Troubleshooting
	Blue Video Screen
	Black Preview Video Screen
	Scrambled Video Image
	Grainy, Dithered Image
	Slow Overlay Drawing
	Problems using Direct Draw
	Poor Video Quality at Large Frame Sizes
	Wrong Capture Driver Being Accessed
	Unwanted Closed Caption Text
	Interrupt Conflicts
	Conflicts Between PCI Cards
	Conflicts of PCI Cards with ISA Cards

	Cannot Play Back Audio Recorded by the Osprey-200 Card
	Multiple Horizontal Lines Across Video Image
	Video Control Dialog Windows are Empty under WinNT

	Appendix A - Hardware Specifications
	Appendix B - Color Modes
	YUV Format Details

	Appendix C - Video Sizes
	Appendix D - Using the Osprey Video Capture Driver with Other Drivers
	To "Add..." a driver, proceed as follows:
	To "Remove" a driver, proceed as follows:

	Appendix E - Direct Draw
	Appendix F - Multiboard Installations
	The Recommended Multiboard Selection Approach
	The Legacy Multiboard Selection Approach

	Appendix G - Files and Registry Usage
	Appendix H - Developer Support
	Appendix I - The Audio Cfg Applet
	Registry Settings Controlled by the Audio Cfg Applet

	Appendix J - Adding/Moving Boards in Windows 2000 and Windows XP

